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Introduction 1

Thank you for choosing SCIEX to supply your LC-MS/MS system. We are pleased to give you
the Analyst software 1.7.4, which provides liquid chromatography-tandem mass spectrometry
(LC-MS/MS) functions.

The Release Notes describe the features in the Analyst software 1.7.4 as well as
troubleshooting guidelines. Use these release notes for reference as you become familiar with
the software, and for future reference. For installation and software compatibility information,
refer to the document: Software Installation Guide.

Note: The Analyst software 1.7.4 is only supported on the Windows 10 operating system.

How to Use These Release Notes

To help you understand what is new and what is fixed relative to your current Analyst software
version, the Release Notes for the Analyst software 1.7.4 have been structured so that you only
have to read the sections that are relevant to you.

Everyone should read Notes on Use, as this section applies specifically to issues that are known
in the Analyst software 1.7.4.

Note: To view the enhancements, fixed issues, and known issues for previous versions of the
Analyst software, refer to the document: Release Notes for previous versions.

Note: The numbers in parentheses are reference numbers for each issue or feature in our
internal tracking system.

Release Notes Analyst Software 1.7.4
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New in Version 1.7.4 p.

This section gives a description of the changes in the Analyst software 1.7.4. To see the
enhancements and corrected issues for an earlier version of the Analyst software, refer to the
document: Release Notes that came with that version of the software.

New Features and Enhancements in Version 1.7.4

The following features and enhancements are available.

Version 1.7.4 includes the enhancements that were included in Analyst 1.7.3 HotFix 1, HotFix
2, and HotFix 3, except for the version of the ConfigUpdater utility that was installed with those
releases. A new version of the ConfigUpdater utility is included in the software package. The
release notes are available on the SCIEX website, at sciex.com/customer-documents.

* The instrument model and serial number are included in the Instrument Optimization reports.
(AN-3469)

» Batch validation is better. If a Shimadzu LC-40 3-Plate Rack with the Plate Changer installed
is used, and if plate # 3 is used in the batch, then a warning message is shown when the
batch is saved. If the batch is submitted, then a failure will occur. (AN-1815)

* When QA reviewers try to open a Results Table that was already opened by a QA reviewer
on a different computer, they can now select Yes or No to open the Results Table as read
only. (AN-3461)

» The limit for the length of a password in the UNLOCK/LOGOUT dialog for Mixed Mode and in
the Set acquisition account dialog has been removed. The limit is now the same as the limit
set by Microsoft Windows. The length of the password field was not changed. (AN-2425)

» The tags that follow have been added and can be used in the reporter templates in the
Analyst software, which are used to print reports.

* ForEach tags: ADC_UV_Channel, IS ADC_UV_Channel.

» TextField tags: ADC_UV_Channel_Name , IS_ADC_UV_Channel_Name.
* Picture tags: IS_ADC_UV, DAD_XWC and DAD_IS_XWC.

(AN-3713, AN-1539, AN-3746)

» Users can now use the Analyst software to process wiff data acquired with the SCIEX OS
software on SCIEX 7500+ systems.

Analyst Software 1.7.4 Release Notes
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New in Version 1.7.4

Analyst 1.7.3 HotFix 1, 2, and 3 Enhancements

HotFix 3 includes the enhancements that were included in the Analyst 1.7.3 HotFix 2 and
HotFix 1.

Analyst 1.7.3 HotFix 3 Enhancements

» Audit trail records can now be exported to PDF. To export the audit trail records, right-click
in the audit trail records pane. This feature lets users with read and write privileges, but no
delete privileges for a folder export the audit trail records. The exported file shows a different
display format than what is shown on the screen.

* A new Instrument Control Board (ICB) version 5 (ICB-5) is supported for SCIEX 3500
systems, SCIEX 4500 systems, SCIEX 5500 systems, SCIEX 5500+ systems, SCIEX 6500
systems, and SCIEX 6500+ systems.

* SCIEX 3500 systems, SCIEX 4500 systems, SCIEX 5500 systems, SCIEX 5500+ systems,
SCIEX 6500 systems, and SCIEX 6500+ systems: A full configuration table header is added
to the File Info for a data file that is acquired with Analyst 1.7.3 HotFix 3 or later to
differentiate between ICB-4 and ICB-5.

+ If an OptiFlow Turbo V ion source with the Nano probe is installed and Scheduled lonization
is not selected in the acquisition method, then the lonSpray Voltage stays on between
sample runs. (AN-1721)

» The software supports the Operating systems Windows 10 version 21H2 and version 22H2.

» The software supports a newer version of the LC driver for the Shimadzu LC-40 system,
Shimadzu LC-20/30 systems configured with the Integrated System Shimadzu LC-20/30
Controller, and ExionLC system.

* The sMRM Calculator script has been updated.

Analyst 1.7.3 HotFix 2 Enhancements

Analyst 1.7.3 HotFix 2 includes the enhancements that were included in the Analyst 1.7.3
HotFix 1 as well as support for the VICI Valco valve 2-position 10-port: UMDA-C10W.

Analyst 1.7.3 HotFix 1 Enhancements

» The option to use the deployment tool to do a new installation of the Analyst software 1.7.3
with the AAC security database is supported.

» Microsoft Office 2021 is supported. For a list of other supported versions of Microsoft Office,
refer to the software installation guide for the Analyst software 1.7.3.

* A new plate layout is available for Shimadzu LC-40 autosamplers.

The Alpha Deep Well MTP 96 plate, a 96 deep well plate layout with alphanumeric numbering
starting from the bottom left of the plate, horizontally, is supported for Shimadzu LC-40
autosamplers. (AN-2758)

Release Notes Analyst Software 1.7.4
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New in Version 1.7.4

* A new plate layout is now available for Shimadzu SIL-30AC and SIL-30ACMP autosamplers
configured with the Integrated System Shimadzu LC Controller or the Integrated System
Shimadzu LC-20/30 Controller, with or without the Rack Changer.

The Alpha Deep Well MTP 96 plate, a 96 deep well plate layout with alphanumeric numbering
starting from the bottom left of the plate, horizontally, is supported. (AN-2223)

* The SIL-30ACMP autosampler can now be controlled using a Shimadzu LC-40 controller
(AN-2707, AN-3037)

* The Analyst Administrator Console (AAC) 3.1 client is installed with the installation of Analyst
1.7.3 HotFix 1. (AN-2836)

» The driver for the ExionLC 2.0 system is updated to version 1.0.0.91 (AN-2759)

» The firmware for the ExionLC 2.0 system has been updated. Contact sciex.com/request-
support to update the device firmware.

* Use firmware version 6.21 for ExionLC 2.0 column switching valves.

* Use firmware version 1.23 for ExionLC 2.0 autosamplers.

Fixed Issues in Version 1.7.4

Version 1.7.4 includes the changes made for issues fixed in Analyst 1.7.3 HotFix 1, HotFix 2,
and HotFix 3.

The following issues have been fixed in this release:

The time shown for the Last Sample Finished in the File Information pane was incorrect
for data files acquired with the Data File Checksum feature off.

If a datafile was acquired with the Data File Checksum feature not enabled, then the time shown
for the Last Sample Finished in the File Information pane was incorrect. This issue has been
fixed for data files acquired or samples appended in version 1.7.4 or later. (AN-3626, AN-1623)

The time was not shown in the Date and Time column in an audit trail for events that
occurred at 12:00:00 AM

If an event occurred at exactly 12:00:00 am, then the time was not shown in the Date and Time
column in the audit trail although the date was shown. (AN-3714, AN-1543)

Some audit trail records might have been overwritten if two QA reviewers at different
computers opened a Results Table at the same time

The audit trail records from the first QA reviewer might have been overwritten by the records
from the second QA reviewer if QA reviewers at different computers opened the Results Table
at the same time. The issue only occurred if after the first QA reviewer closed the Results Table,
the second QA reviewer did one of the following:

Analyst Software 1.7.4 Release Notes
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1. Clicked No in the Whether to Reload dialog.

2. Clicked Yes in the Whether to Reload dialog and subsequently clicked Cancel in the Adding
Annotation dialog, if applicable.

3. Clicked Yes in the Whether to Reload dialog and subsequently clicked Cancel in the Save
Quantitation Results dialog. (AN-3461)

In the File Information pane for some systems, the incorrect status or parameters that
were not applicable were shown

In the File Information pane for a data file acquired with a SCIEX 3500 system, SCIEX 4500
system, SCIEX 5500 system, SCIEX 5500+ system, SCIEX 6500 system, or SCIEX 6500+
system, the status for flow of the Curtain Gas was Bad even if the flow reading was a valid
value. There were also parameters that were not applicable to the pumps. After the issue was
fixed, the Interface Turbo Pump, Analyzer Turbo Pump, Backing Pump, and Interface Pump
parameters were removed. The Turbo Pump and Roughing Pump parameters were added.

For SCIEX 6500+ systems and SCIEX 6500 systems, there are two roughing pumps. The
Roughing Pump 1 and Roughing Pump 2 parameters have been added to replace Roughing
Pump parameter. (AN-1588, AN-2332)

A valid, but incorrect, number was shown in the Formula column although an invalid
value "#DIV/0!" in the Calculated Concentration column was used for the calculation

If an invalid value "#DIV/0!" was shown in the Calculated Concentration column, and the value
is used for the Formula column calculation, then a valid, but incorrect, number was shown in the
Formula column. (AN-3578)

A different quantitation algorithm name was shown in the Analyst Reporter

Reports created from Analyst Reporter showed the quantitation algorithm as MQL instead of MQ
lll, which was used in the Analyst software. After the issue was fixed, the quantitation algorithm
name in Analyst Reporter is the same as the name shown in the Analyst software. (AN-1510)

Users who were not individually added but belong to a group under the Analyst People
tab could not use Instrument Optimization

If a user belonged to a group that was added to the Analyst software People tab, but was not
individually added to People tab in Security Configuration, then this user would not be able to
run Instrument Optimization. (AN-2575)

Greyed-out rinsing mode instead of NA was shown in File Information pane for data
files acquired with a Shimadzu LC-30 system configured through the Integrated System
Shimadzu LC Controller

If External was selected for Rinse type, then the Rinse Port Liquid field was not available
in the acquisition method although the default R1 was visible in the field. In File Information

Release Notes Analyst Software 1.7.4
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New in Version 1.7.4

pane, the text R1 for the greyed-out Rinse Port Liquid Selection was shown instead of NA.
(AN-1576)

Extracted wavelength chromatograms were not shown in reports created with the Analyst
Reporter

For DAD data, no picture tags were available in the Analyst Reporter template. The extracted or
single wavelength chromatograms for an analyte or internal standard could not be shown in the
reports generated from the Analyst Reporter. (AN-1539)

Analyst Reporter tags IS_Peak_Area_for_DAD and IS_Peak_Height_for_DAD did not
supply correct results

If the Analyst Reporter used a report template that contained the IS_Peak Area_for_DAD tag,
and the Results Table selected contained valid values in the IS Peak Area for DAD column,
then, for DAD, the report that was created showed "N/A" for the IS Peak Area for DAD. The
same issue occurred if a report template contained IS_Peak_Height_for_DAD. (AN-1497)

If a non-default Table Settings was used for a Results Table, then the audit map shown in
the Settings tab might have been incorrect

When a non-default Table Settings was used for a Results Table, the audit map in the high level
window in the Settings tab might have been incorrect and the modified date or time were not
shown. However, the correct information was shown when users clicked Details for that audit
map. (AN-3602)

The Analyst software might no longer respond if the Peak Review pane was printed for a
Results Table

The Analyst software might no longer respond when the Peak Review pane for some Results
Tables was printed, regardless of the printer used. (AN-2419)

If Scheduled lonization was enabled, then the user could not type an RT value that was
larger than the value in the Duration field in the Include List or Exclude List in an IDA
method

If an IDA method had Scheduled lonization enabled, then in the Include List or Exclude List
on the Include/Exclude tab in the IDA Criteria, the user could not type an RT value that was
larger than the unavailable value shown in the Duration field on the MS tab for the survey or
dependent experiments. (AN-2090)

Instrument Audit Trail recorded NA in the User Name column for the Queue event when
batches were moved

The Instrument Audit Trail recorded NA for the user who moved the batches in the queue. After
this issue was fixed, the correct user and full user name is recorded in the Instrument Audit Trail
if a user moves a batch. (AN-1347)

Analyst Software 1.7.4 Release Notes
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New in Version 1.7.4

Issues Fixed in Analyst 1.7.3 HotFix 3 and Included in the
Analyst Software 1.7.4

Images might not have been shown in large reports that were printed from the Analyst
Reporter

The computer performance and the available memory can have an effect on report generation.
On some computers, one or more images might not have been shown in large reports that

were printed from the Analyst Reporter. In the report, This image is not available was
shown as an alternative to an image of the correct chromatogram. Usually, this issue might have
occurred if a Results Table contained multiple data files. (AN-3460)

A memory leak might have caused a batch to stop if a system with a Shimadzu LC was
in operation for a long time while the StatusScope remote monitoring service was also in
operation

If a system with a Shimadzu LC was in operation for a long time at the same time that the
StatusScope remote monitoring service was also in operation, then a memory leak might have
occurred and stopped the batch. The issue might occur with a Shimadzu LC-20/30 configured
through the Integrated System Shimadzu LC-20/30 Controller, Shimadzu LC-40, or ExionLC
system. (AN-3272)

A user who did not have delete permission for the API Instrument\Instrument
Optimization folder could not run Instrument Optimization.

A user could not run Instrument Optimization if the user did not have delete permission for
the D:\Analyst Data\Projects\API Instrument\Instrument Optimization folder.
(AN-593)

The Analyst software might have stopped working or changed the sample type of the
incorrect row if the Results Table had more than one analyte in Full Layout view, and
the user changed the Sample Type column, and then, without clicking anywhere else,
changed to another table layout.

If the user clicked on a different sample type in the Sample Type list while the Results Table
was in Full Layout view, and then immediately selected a different table layout that decreased
the total number of rows to be shown, the Analyst software might change the sample type of an
incorrect row or the software might stop working. (AN-2654)

If the last experiment was deleted, then the value of the parameter in the first experiment
in an acquisition method might have been changed

If a method had three or more experiments of the following scan types, whether the same kind
or mixed, and if the last experiment was deleted, then the precursor ions, such as product of for
Product (MS2) and EPI scan types, 1st precursor and 2nd precursor for the MS3 scan type,
Precursor Of for the Precursor lon (Prec) scan type, or Loss of for the Neutral loss scan

type in the first experiment were replaced with the precursor ions from the deleted experiment,
regardless of whether the first and the deleted experiments had the same scan type. Other

Release Notes Analyst Software 1.7.4
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New in Version 1.7.4

parameters and the mass range remained for the original first experiment. The following scan
types were affected:

- EPI

+ MS3

* Product (MS2)

* Precursor lon (Prec)

* Neutral loss
(AN-2276)

The sort feature for a column in the sMRM Calculator script might not have worked
correctly if the number of digits before the decimal was not the same for all transitions for
the MRM algorithm

If a method was opened in the sMRM Calculator script, then the option to sort the column in
increasing or decreasing order might not have worked correctly. If the number of digits before
the decimal for all MRM ftransitions in a column was the same (example: all RTs were above

1 but below 10 min), then there was no issue with the sort feature. There might have been an
issue if some RTs were below 10 minutes and some were above 10 minutes (example: RT=1.2,
2.5, 10.6). (AN-1353)

Scheduled MRM (sMRM) Pro algorithm: File Information showed 0.0 for those transitions
if, in the method, the MRM Window (sec) fields were left empty

When a method with the Scheduled MRM (sMRM) Pro algorithm was created, the user could
type a value for the MRM Window (sec) field to supersede the MRM detection window (sec)
set in the method. If the user left this field empty, then the transition used the MRM detection
window for acquisition, but the File Info showed 0.0 in the Window (sec) column for that
transition. (AN-270)

The Analyst Reporter might have created a Metric Plot that did not match the one shown
in the Analyst software

When the Analyst Reporter created a report that contained a Metric Plot that used sample
indices, then the plot looked different from the one shown in the Analyst software. In the report,
the sample indices of the data points incorrectly started at 0, whereas in the Analyst software,
the sample indices started at 1. (AN-1640)

If only some of the samples from a data file were included in the Results Table and if a
point was excluded from a Metric Plot, then incorrect information might have been shown
in the Details column in the Results Table audit trail records

If some samples from a data file were excluded from the Results Table, either because the
user did not add all of the samples from the data file to create the Results Table, or if the

user removed some samples from the Results Table after it was created, and if the user then
excluded one or more points from the Metric Plot that was created from that Results Table, then

Analyst Software 1.7.4 Release Notes
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an incorrect sample name and number might have been shown in the Details column in the
Results Table audit trail records. The issue only occurred if the point in Metric Plot that was
excluded was for a sample that was acquired after the samples were excluded from the Results
Table. (AN-1491)

If the Results Table contained multiple analytes, and if a user excluded or included a
point from a Metric Plot, then incorrect information was shown in the Details column in
the Results Table audit trail records

If a Results Table contained multiple analytes, then the exclusion or inclusion of an analyte point
for a sample caused an incorrect analyte name for that sample to be shown in the Details
column in the Results Table audit trail records. (AN-3369)

An incorrect UV picture tag was shown in the Analyst Reporter

The absorbance chromatograms in reports created by the Analyst Reporter might not have
matched those in the Peak Review pane in the Results Table. The negative Y-axis, if there was
negative absorbance, was not shown in the report, and the Y-axis was always set from 0 mAU to
1000 mAU regardless of if the Y-axis min was set or not. (AN-2046)

More Analyst software warnings than were necessary were written in the application
event log

The following Analyst software warning was written over and over in the application event log:
The description for Event ID 3 from source Analyst cannot be found.
Either the component that raises this event is not installed on your
local computer or the installation is corrupted. You can install or
repair the component on the local computer. (AN-3196)

ADC data with an incorrect scale factor might be shown for configurations with an
integrated system and A/D converter.

If a configuration with an integrated system that was added before the A/D converter in the
hardware profile, such as MS + Shimadzu Integrated System + ADC, was used to acquire ADC
data, then a different scale factor than what was expected was shown in Explore mode. This
issue did not occur with hardware profiles where the integrated system was added last, such as
MS + ADC + Shimadzu Integrated System. (AN-3321)

The content in Weight/Volume column for a sample was not shown in File Info

If a batch that had values entered in the Weight/Volume column on the Quantitation tab of the
batch was submitted and acquired, then the Weight/Volume information was missing from the
File Info of the data files that were acquired. (AN-3126)

sMRM Calculator script fixes and improvements:

» As in the Analyst software, the sMRM Calculator script accepts decimal places in the
Window column. (AN-3364)

Release Notes Analyst Software 1.7.4
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» All of the columns in the sSsMRM Calculator script can be sorted in alphanumeric order.
(AN-3353)

+ Warning messages give better information when a user enters an invalid value or loads
a method that does not use the Scheduled MRM (sMRM) algorithm. (AN-3351, AN-3334,
AN-3310)

» The sMRM Calculator script supports Scheduled lonization acquisition methods. (AN-3312)

* The sMRM Calculator script can open a method that uses the Scheduled MRM (sMRM)
algorithm in Mixed Mode. (AN-3311)

The transitions with Retention Time of 0 minutes were not shown correctly in the graphs
in the sMRM Calculator script

A transition with a Retention Time of 0 minutes in a method that uses the

Scheduled MRM (sMRM) algorithm was monitored throughout the run duration. However, in the
sMRM Calculator script, this transition was not fully shown in the Method Overview graph, and is
not fully included for counting or calculation throughout the run duration in the Concurrency and
Cycle Time graphs. In addition, the MRM index on the Y-axis in the Method Overview was off by
1. Y-1 was shown even though it was supposed to be the Y value.

Note: The algorithm for dwell time calculation is not changed from the one used in previous
versions. Refer to the section: Acquisition.

(AN-1620)

Issues Fixed in HotFix 2 and Included in the Analyst Software
1.7.4

The Analyst software stopped working when users printed from the File > Print >
Workspace

If data, such as methods or Results Tables, was printed from the File > Print > Workspace,
then the Analyst software stopped working even though the data was printed successfully. There
is no issue if users print from the File > Print > Window or File > Print > Pane. (AN-2079)

The Quantitation Wizard added an incorrectly selected sample if one of the datafiles had a
checksum error

In Quantitation Wizard, if users clicked Add All Files to add multiple datafiles to the Selected
Samples list, and if one of the datafiles had a checksum error, then the datafile with a checksum
error was not added but the sample from the next datafile that had a valid checksum or had no
checksum was added twice. (AN-1653)

If data was being acquired with the Shimadzu PDA or ExionLC PDA in 2D mode with the
slow sampling rate, then data acquisition occasionally stopped at the end of the run and
did not move to the next sample

Analyst Software 1.7.4 Release Notes
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If an acquisition method that included a Shimadzu PDA or ExionLC PDA used the slow sampling
rate, such as 2000 ms in 2D mode, to acquire data, then acquisition might have become stuck at
the end of the run and did not move to the next sample in the batch. (AN-2980, AN-2975)

Users assigned a non-administrator role that had Overwrite Acquisition method access
enabled but did not have delete rights enabled for the Analyst Data folder could not
overwrite methods in Tune and Calibrate mode

A user with a non-administrator role that had Overwrite Acquisition method access enabled
but did not have delete rights enabled for the Analyst Data folder could overwrite acquisition
methods in Acquisition mode but not in Tune and Calibrate mode. (AN-2732)

If an internal standard was defined in the second period, then it could not be selected for
use in the first period in the Analyst software 1.7.3 quantitation methods

If a user was making a quantitation method in the Analyst software 1.7.3 with or without HotFix 1
installed, then if the internal standard was defined in the second period, it could not be selected
for use in the first period. (AN-2979)

Corrupted audit trail records might have been shown when special characters were used
in the Change Description

If special characters such as a carriage return or a new line were used in the Change
Description for an audited event, then corrupted audit trail records might have been shown.
(AN-2733)

The Analyst software audit trail records showed the full name of the user instead of the
display name

In the Analyst software versions 1.7.2 and 1.7.3 with or without HotFix 1 installed, the Full User
Name field in the audit trail records showed the full names of the users instead of the Display
Names that were stored in the Windows Server Active Directory. This behavior was different
from what was shown in versions before 1.7.2. After the fix, the Display Names are shown in
the Full User Name field in audit trail records. (AN-2447)

The File Info might show incorrect information for some Agilent pumps that were directly
controlled by the Analyst software

If Agilent 1260 pumps were directly controlled by the Analyst software and not controlled using
the Analyst Device Driver, then the values for the Max Pressure Ramp and Max Flow Ramp
reported in the File Info were interchanged. In addition, the Max Flow Ramp Up and Max Flow
Ramp Dn information was shown in the File Info for all Agilent pump models that were directly
controlled by the Analyst software even though they only applied to the Agilent 1290 G4220A
and Agilent 1290 G4220B pump models. (AN-2754)

A target project was not made if there was a double backslash in the middle of a network
path for the Project Source Directory and Project Destination directory

The Analyst software does not generate a double backslash (\\) in the middle of a network path
for a project. However, for some reason, if the user copied a project in the Analyst software, and
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if a \\ was in the middle of a network path in both the Project Source Directory and Project
Destination directory fields, then the Analyst software was unable to make the target project.
The workaround was to replace the double backslash (\\) with a single backslash in the Project
Source Directory field. (AN-2568)

The toolbar in the Analyst software did not refresh correctly after the user clicked the
icon for the Administrator Console Connectivity Settings.

In Configure mode, after the user clicked the icon for the Administrator Console Connectivity
Settings in the toolbar, the right side of the toolbar, where there are no toolbar icons, could not
be seen.
Figure 2-1 AAC Icon (Old)
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This issue is fixed in this release. This HotFix introduces a new icon, shown in the following
figure, for the Administrator Console Connectivity Settings and a tooltip, AAC settings.

Analyst Software 1.7.4 Release Notes
16/97 RUO-IDV-03-0236-H



New in Version 1.7.4

Figure 2-2 AAC icon (New)
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(AN-1204)
Positive and negative spikes could have been shown in PDA data acquired in 2D mode

If PDA data was acquired in 2D mode with a Shimadzu SPD-20 or SPD-30 configured through
the Integrated System LC-20/30 Controller, or a Shimadzu SPD-40, or an ExionLC PDA, then
positive and negative spikes could have been shown if the acquisition method used a high
sampling rate and included more than one channel. (AN-3022)

A user could still use the Analyst software in Mixed Mode after the Analyst software had
been screen locked

If a user logged on to the Analyst software workstation using a VPN, or disconnected from the
network when the Analyst software screen was locked, then an Unspecified error message
was shown. If the user waited for approximately 20 seconds, and then clicked OK in response to
the error message, then the unlock screen dialog was shown. However, the user still could use
the Analyst software while the unlock screen dialog was shown. (AN-3004)

Users might have not been able to edit or create report templates in Microsoft Office

On a workstation with Microsoft Office 2013, 2016, 2021 or Office 365 installed, and with

a very high level of security policy applied, users might have gotten a certificate error for
TemplateContentControlManager.vsto when they tried to open any reporter template for
the first time on the computer. As a result, this add-in required for editing templates could not be
installed because the file TemplateContentControlManager.vsto was not digitally signed.
After this HotFix is installed, users can install this add-in with Microsoft Office 2013, 2016, 2021
or Office 365. Users can also edit or make a report template in Microsoft Office 2013, 2016, and
2021. Depending on the version of Office 365, users might not be able to edit or make a report
template in Office 365. If this issue occurs, then contact sciex.com/request-support. (AN-3202)
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The Analyst Reporter might have grouped some analytes incorrectly and might not show
data for some of the analytes

This issue occurred if analytes that belonged to different analyte groups had names that started
with the same characters and one of these analytes ended in 1. For example:

* Morphine 1
* Morphine 2
* Morphine Dihydro 1
* Morphine Dihydro 2

These analytes should be in two separate analyte groups, but the Analyst Reporter incorrectly
put all of the analytes in one group. In addition, some of the analytes were not printed in the
report. Instead, one of the analytes was reported multiple times to replace those that were not
reported.

After the fix is installed, if analytes are to be included in same analyte group, then the analyte
names must end with a space and then an integer, and the characters from the start of the
analyte name to immediately before the last space character must be the same. Analyte names
have always been case sensitive. Thus, Morphine 1 and Morphine 2 are in the same group,

and Morphine Dihydro 1 and Morphine Dihydro 2 are in the same group. However, analytes with
names such as QAXL 357 1 and QAXL 225 2 would not be in the same group. To put these
analytes in the same group, the user must rename the analytes. (AN-1645)

If a Reporter template was made with a newer version of Microsoft Word, then an extra
empty line might be printed for each analyte or sample

SCIEX has tested versions of Microsoft Word from 2016 and 2021. If the For Each tag was
used in a Reporter template that was made with a newer version of Microsoft Word, then the
printed Results Table report might contain an extra empty line for each analyte or sample. If

the If condition was not met for some analytes or samples, then the report contained a large
blank space between analytes or samples, depending on how many samples or analytes did not
meet the condition. This issue occurred because newer versions of Microsoft Word introduced

a hidden empty line after the For Each tag. The empty line could not be removed when the
template was made because the line was hidden. (AN-3104)

The exported text file and PDF file for a Results Table showed an error if the Analyte
Slope Baseline column data started with a -7

If a value in the Analyte Slope Baseline column of a Results Table started with —7, for example
-7.0054e001, then the exported text file and PDF file of the Results Table showed #D1Vv/0!
for that value. (AN-3254)
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Issues Fixed in HotFix 1 and Included in the Analyst Software
1.7.4

Shimadzu LC-40 systems: The Analyst software batch stopped intermittently if non-
default values for the autosampler rinse mode and rinse method were selected

If the Shimadzu LC-40 system was used with the Analyst software 1.7.3, then the batch might
stop if, in the LC method, non-default values were selected for the autosampler rinse mode
and rinse method. (AN-2901)

Batch submission failed when a specified rack was selected in the acquisition method for
Shimadzu 20/30 autosamplers that had a rackchanger configured for use

If a Shimadzu autosampler with a rackchanger that was configured for use through the
Integrated Systems Shimadzu LC20/30 Controller was used, then the batch submission failed if
the Specify Rack option was selected in the acquisition method. (AN-1806)

Batch submission might have failed if a specified rack was selected in the acquisition
method for Shimadzu 20/30 autosamplers that did not have a rackchanger configured

If a Shimadzu autosampler that did not have a rackchanger configured through the Integrated
Systems Shimadzu LC20/30 Controller was used, then the batch submission failed if the
Specify Rack option was selected and Rack 1.5 mL 105 vial or Rack 1.5 mL 70 vials was
used in the acquisition method. (AN-2805)

If the Analyst Classic quantitation algorithm was used to quantitate poorly separated
small peaks, then a smaller peak area than expected might be calculated when an
atypically large value for the Separation Height or Separation Width was used for
integration

If the Analyst Classic quantitation algorithm was used to calculate the area of a small peak that
is on the shoulder of a large peak that eluted before or after the small peak, then the automatic
integration that used an atypically large value for the Separation Height parameter, such as
0.6 (defaultis 0.01), or the Separation Width parameter, such as 4.0 (defaultis 0. 2) could
cause the peak area to be calculated with a lower value than if the peak area was integrated
manually.

This issue might only occur if peaks that are not well separated are integrated. The issue has
been fixed for any Results Table that is made using the Analyst 1.7.3 HotFix 1 or later. If a
Results Table was created using the Analyst software, version 1.7.3 or an earlier version, then
opening or editing the Results Table or updating other integration parameters in Analyst HotFix 1
or a later version will not cause the new peak area calculation. To update the calculation for an
analyte, in the Results Table, change the quantitation method by removing the analyte and then
adding the analyte back. Click Tools > Results Table > Modify Method. The peak area will be
calculated for the newly added analyte. (AN-2844)

In the Analyst Administrator Console (AAC) users could add projects from multiple
Project Roots but the Analyst software could only access projects from one Project Root
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In the AAC, the Workgroup > Projects node let projects from multiple Project Roots be added.
However, in the Analyst software, only projects in the Project Root that was created first were
accessible by the user. In the Analyst 1.7.3 HotFix 1 and later versions, the user can access
projects from different Project Roots using the Root Selection dialog when the Analyst software
is opened. (AN-2565)

Opening the File Info pane when multiple data files were open in the Analyst software
Explore mode might slow system performance

If different data files were open in Explore mode, if each of the data files had File Info open, and
if the user clicked Show Next Sample, Show Previous Sample, or Go To Sample to move to
a different sample for one of the data file windows, then the system performance might be slow
when the File Info pane was updated. (AN-2843)

Deactivating a hardware profile that included the ExionLC 2.0 system might intermittently
fail

Intermittently, when a user tried to deactivate a hardware profile that included the ExionLC 2.0
system, the following error messages are shown: The remote procedure call failedor
The RPC server is unavailable. To resolve this issue, close and then open the Analyst
software. (AN-2766)

Analyst 1.7.3 Patch for Shimadzu LC30 & LC40 Plate Layout (AN-2771)

This patch is included in HotFix 1. The patch gives support for a new plate layout for

the Shimadzu SIL-30ACMP and Shimadzu SIL-30AC autosamplers configured through the
Integrated System Shimadzu LC Controller or the Integrated System Shimadzu LC-20/30
Controller, and for supported Shimadzu LC-40 autosamplers (AN-2223, AN-2758).

» 96 deep well plate layout with alphanumeric numbering starting from the bottom left of the
plate. The following Rack Codes are available in the Batch Editor:

» Shimadzu SIL-30ACMP and SIL-30AC: Alpha Deep Well MTP 96
* Shimadzu LC-40 autosamplers: Alpha DWP 96

The following are applicable when the new plate is selected for the Shimadzu SIL-30ACMP and
Shimadzu SIL-30AC autosamplers, or for a supported Shimadzu LC-40 autosampler:

» The locations in the Batch Editor are assigned numeric values, arranged horizontally.
» The Batch Editor supports the "fill down" feature.
* The Batch Editor can export to txt and csv files.

* The Batch Editor can import from txt and csv files.
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The following is a list of known issues, limitations, and important notes on using the software.
There might be other issues or limitations with the Analyst software in addition to those listed in
this section. If you find additional issues, contact SCIEX at sciex.com/request-support.

In general, if the Analyst software is not responding, then restarting the software might help. If
this does not work, then restart the computer to make sure that the AnalystService and device
drivers restart.

Guidance for Antivirus and Backup Software

Many widely-used applications can be configured to either disable real-time protection or ignore
certain file types (for example, rdb, wiff, and wiff.scan). Failure to configure them in this way
might result in either failed acquisitions or acquisitions that take longer to complete than
expected.

In general, the antivirus or backup software on the Analyst software acquisition workstations
should be configured in a manner that disables real-time scanning and archiving of files in the
Analyst Data folder. For more information, refer to the section: Cybersecurity.

Exclude the following list of programs from consideration by real-time scanning:

* C:\Program Files (x86)\Analyst

* D:\Analyst Data

If the Agilent Infinity II, CTC PAL3, and the associated Device Driver for the Analyst software is
used:

* C:\Program Files (x86)\AB SCIEX\AnalystDeviceDriver

For the latest guidance on cybersecurity for SCIEX products, visit sciex.com/productsecurity.

Guidance on File Encryption

When using software to encrypt the contents of your hard drive, make sure that the Analyst
Data folder is not encrypted. Encrypting this folder might result in failed acquisitions or corrupted
data files.

General

*  We recommend that the computer be restarted at least once a week.

« As of version 1.7.4, the ShowMe.exe is not installed.
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* Microsoft Office compatibility

» As of version 1.7.4, Microsoft Office 2013 is not supported.
* Microsoft Word 2016, Microsoft Word 2021, or Office 365 must be installed.

Note: Microsoft Office 365 ProPlus is not compatible with computers with the Windows 10
LTSB/LTSC operating systems.

» Microsoft Word 2016 or 2021 is required to make, open, or edit the report templates used
in the Reporter software. Microsoft Office 365 cannot be used to create, open, or edit
report templates that are used in the Reporter software. However, the Analyst software is
compatible with Microsoft Office 365 for all other functions. Microsoft Office 365 can be
used to generate a report in Instrument Optimization, and in Analyst Reporter with a report
template that was installed with the software, or with a report template that was created
with Microsoft Office 2013, 2016, or 2021.

» For some reporter templates, an empty line in an empty section in a reporter template
does not show in the corresponding section in the report that was generated using this
template. To fix this issue, in the reporter template, add a space in the first empty line in
the empty section where the empty line is missing in the related report. Save the reporter
template with a different name and then use it to generate reports. This behavior change is
because of an Analyst software update that was made for the reporter templates that were
changed in Microsoft Office Word version 2016 or later.

» As of version 1.7.4, the Set configuration as default for new projects option in the Create
New Project/Subproject dialog is no longer available. (AN-1730)

» As of version 1.7.4, MSXML version 4 is no longer installed by the Analyst software.

» As of version 1.7.3, the About Analyst dialog has been changed to include the software
version information in the following format, without a build number:

* Analyst software
* Published Version: 1.7
* Full Version: 1.7.3 (1.7.3 HotFix 3)

« The special characters $ and % are not supported in the Analyst software for user names.
Avoid using these special characters in user names. (AN-2369)

» As of version 1.7.3 to decrease the risk of instrument contamination, the default CUR setting
has been changed to 35 for SCIEX 3500 systems, SCIEX 4500 systems, SCIEX 5500
systems, SCIEX 5500+ systems, SCIEX 6500 systems, and SCIEX 6500+ systems.

* Do not start Analyst software file names with “-“ or any other special characters. This is
applicable to files including, but not limited to, data files, method files, and Results Table files.
It is highly recommended to start the file name with an alphanumeric character. (AN-2430)
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» Because virtual machines can be complex, it is not possible to test or support every
configuration of virtual machines. Therefore, SCIEX limits support to physical, supported
computers.

* Avoid the use of illegal characters or names for the Analyst software file name and a file path
for an Analyst root directory. The Analyst root directory path works the same as the path in
the Windows operating system. Do not use the following characters in the Analyst software
file names and paths to the Analyst root directory, as in the Windows operating system.

# pound

% percent

& ampersand

{ left curly bracket
} right curly bracket
\ back slash

< left angle bracket
> right angle bracket
* asterisk

? question mark

/ forward slash
blank spaces

$ dollar sign

! exclamation point
' single quotes

" double quotes

: colon

@ at sign

+ plus sign

" backtick

| pipe

= equal sign
emaojis

alt codes
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In addition to these characters, do not start or end the name of a file with a space, period,
hyphen, or underline.

File and folder name validations are done by the Windows operating system and not by
the Analyst software. Do not use the following file names that also cannot be used in the
Windows operating system:

CON, PRN, AUX, NUL, COMO, COM1, COM2, COM3, COM4, COM5, COM6, COM7, COMS,
COM9, LPTO, LPT1, LPT2, LPT3, LPT4, LPTS5, LPT6, LPT7, LPT8, and LPT9. (AN-3273)

» As of Analyst 1.6.3 HotFix 2, the results file for the Instrument Optimization results summary
is printed in PDF format. A supported version of Microsoft Office must be installed.

* Only the files installed by the Analyst software should be stored in the D: \Analyst

Data\Projects\API Instrument\Instrument Optimization\settings folder.
Customized csv files stored in this folder are not supported. (AN-1522, AN-1551)

* Domain field is not available in the Analyst - Logon Information dialog. The Domain field has
been removed from the Analyst - Logon Information dialog if the software is configured to
use Mixed Mode security. The user name field can be in SAM (domain\username) or UPN
(username@domain.com) format. (AN-1564)

* Do not modify the computer date and time after the Analyst software is installed. Make sure
that the computer date and time is correct on the computer before installing the Analyst
software. After the Analyst software is installed, manually modifying the date and time will
invalidate the license and cause users to be unable to log into the Analyst software.

»  Workstation recommendations: If a customer-supplied computer is used with the system, then
a best effort will be made to support and troubleshoot any issues. However, in some cases, a
standard SCIEX-supported computer configuration will be required for further investigation.

* Network Environment
The Analyst software supports the Windows-based LAN networks.
* File Server

The Analyst software only supports Windows-based file servers. We recommend that the file
server be in the same building as the mass spectrometer. Contact Microsoft or the hardware
and software vendors for specification recommendations.

Note: Previously, Windows Server 2008 R2 and 2012 were specifically mentioned. During
testing we have found that compatibility is not version-dependent.

* The minimum advanced permissions required by the Analyst software to store a result file:
For the minimum permissions required to store a result file, refer to the following figure.
(AN-1994)

Note: If the user of the Analyst software is in multiple domain user groups, then the folder
permission for the user is a cumulation of the permissions assigned to each of these groups.
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Figure 3-1 Permission Entry for Analyst Data Dialog
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» The toolbar in the Analyst software might not refresh correctly when scaling is changed. The
toolbar might not refresh correctly under the following conditions:

* The user moved a remote desktop session window in which the Analyst software was
open from one monitor to another with a different monitor scaling setting, minimized the
software window, and then maximized it.

» The user connected remotely to a workstation with the Analyst software installed from
a computer using a monitor with a different scaling setting from what was set on the
workstation monitor, logged on the Analyst software and left the software open, ended
the remote session, and then logged on directly to the workstation on which the Analyst
software was left open.

The right side of the software toolbar where there are no toolbar icons cannot be seen. If
users change between modes, then the toolbar icons from the previous mode might persist
in the user interface and cannot be clicked, and some icons on the toolbar look like they

are shown twice. The workaround is to close the Analyst software and then open it again.
This is a Microsoft behavior where some applications do not respond to scaling changes until
the applications are closed and then opened. To prevent the issue during a remote desktop
session, make sure that the Analyst software is closed before the remote desktop session is
stopped, and then start the next remote desktop session. Do not move the remote desktop
session between monitors with different scaling settings. Alternatively, use the same scaling
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setting on all monitors connected to the computer used to connect remotely to the Analyst
software. For example, set all monitors to 125% scaling. To prevent any display issues,
when logging on directly to the Analyst workstation, make sure to close the Analyst software
before stopping the last remote session or use the same scaling setting on monitor on the
workstation with the Analyst software and the monitor on the remote desktop. (AN-3205)

All associated Analyst software folders or files must be created or edited in the Analyst
software to maintain 21 CFR traceability. File and folder level permissions for users must be
set in accordance with the standard operating procedures of the laboratory.

CTC PAL autosamplers (HTC and HTS models) will not be compatible for instrument control
or data review as of version 1.7.4. When the File Info is opened for a datafile that was
acquired with a CTC PAL autosampler and an earlier version of the Analyst software, the
CTC PAL method description is not shown.

National Instrument ADC card support: The older model of National Instrument ADC card
(PCI-6032E) is not supported in Analyst 1.7.3 HotFix 2 or later versions.

Each time a hardware profile is activated, the time stamp of its hwpf file in Windows Explorer
changes. By design, when a hardware profile is activated, the time stamp of its hwp £ file
changes. This is because specific parameters must be read from the mass spectrometer

and the hardware profile manager to update the hwpf file during the activation process.
(AN-1803)

Acquisition

Compound Optimization is only supported in local acquisition and not for network acquisition.
(AN-3591)

During acquisition, do not change or modify software settings or configurations. (AN-1545)

Each acquisition method and LC configuration is specified for each hardware profile.

» If a user edits the hardware profile for a specified LC configuration, for example, the
solvent valve for an ExionLC pump, then the acquisition methods created with the original
hardware profile must be saved again, after the edited hardware profile is activated. The
settings in the LC method must match the settings for the LC devices in the hardware
profile.

If the LC settings of a hardware profile are changed and the updated hardware profile

is activated, and if a method that was created with the original LC settings is used to
acquire data, then the some LC settings from the original hardware profile might be used
to acquire data. The LC settings in a hardware profile are saved in the acquisition method
even though that LC setting is not included in the acquisition method editor. (AN-2455)

» If a hardware profile with a Shimadzu LC-20 series autosampler that has one of these
rinse mode options selected: before aspiration, after aspiration, or before and after
aspiration is edited and the Rinse Pump Installed check box is cleared, then any
acquisition methods that were created with the original hardware profile must be saved
again after the hardware profile that was edited is activated. (AN-1143)
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+ As of the Analyst software 1.7.3, the Settling Time field for Scheduled MRM (sMRM)
algorithm experiments is not available to be edited for all mass spectrometer models except
for SCIEX 6500 systems and SCIEX 6500+ systems. For other mass spectrometer models,
the values being used are defined in the software and cannot be changed in the user
interface of the Method Editor.

* A change made manually to a cell in the Batch Editor takes effect only after the user clicks
outside of the cell that was changed. In a batch, after a change is made manually to a cell,
such as to change to a different vial position, the software does not update the value until the
user clicks a different cell or tab, or presses Enter on the keyboard. If a user makes a change
to a cell, does not move the cursor, and then saves the batch, then the change is not saved.
(AN-3384)

* Network acquisition: Special Acquisition Administrator Account

If the Special Acquisition Administrator Account is not used for network acquisition,

then the user logged on to the Analyst software must have Delete permission for the

WIFF CACHE BACKUP folderinthe D:\Analyst Data folder. If the Special Acquisition
Administrator Account option is used, then the user logged on to the Analyst software does
not need access permission for the WIFF CACHE BACKUP folder in D:\Analyst Data
folder. However, the Special Acquisition Administrator Account must have, at a minimum,
Modify permission, with Delete permission included for the WIFF CACHE BACKUP folder. For
more information about the Modify permission, refer to the following figure. (AN-1994)

Figure 3-2 Advanced Permissions

Advanced permissions:

[] Full control [] Write attributes

Traverse folder [ execute file [] Write extended attributes
List folder / read data ] Delete subfolders and files
[] Read attributes [] Delete

[] Read extended attributes [] Read permissions

[] Create files / write data [[]Change permissions
Create folders / append data [] Take cwnership

» To prevent network-related acquisition issues, use a Special Acquisition Administrator
Account for network acquisition. For more information about the Special Acquisition
Administrator Account, refer to the Analyst software document: Laboratory Director Guide
or Help.

» Acquisition methods containing four pumps and created in a version earlier than the Analyst
1.7 with HotFix 3 cannot be opened in newer versions of the Analyst software. If an
acquisition method uses four pumps and is made in a version earlier than the Analyst
software 1.7 with HotFix 3, then this method cannot be opened in the Analyst software 1.7
with HotFix 3 or in newer versions of the Analyst software. The method must be made again
using the new hardware profile made in the Analyst software 1.7 with HotFix 3 or a later
Analyst software version. (AN-2818).
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* Acquire each sample to a different data file if an ExionLC PDA or a Shimadzu PDA is used.
We recommend that each sample be acquired to a separate data file if an ExionLC PDA or
a Shimadzu PDA is used. Doing so can prevent intermittent batch stoppages that are caused
when large amounts of data are written to a single file. (AN-1823, AN-2920, AN-2901)

* In Analyst 1.7.3 HotFix 3 and later versions, the Method Overview, Concurrency, Cycle Time
and Dwell Time graphs in the sMRM Calculator script are updated to show the behavior
during acquisition where transitions with a retention time of 0 minutes are collected for the
entire run duration. However, the dwell time calculation algorithm used in both the sMRM
Calculator script and Scheduled MRM acquisition in the Analyst software stays the same
as in earlier versions. That is, for dwell time calculation only, the transitions with a retention
time of 0 minutes are treated as transitions to be run from 0 minutes to 0 plus half of
the detection window time, and for any transitions scheduled to be run after that, those
transitions are not considered as concurrent transitions with the ones with RT=0. This is
by design. In addition, in Analyst 1.7.3 HotFix 3 and later versions, the transitions with a
retention time of 0 minutes are shown as RT=half of the run duration for methods without
Scheduled lonization selected, or as RT=half of the (Stop Time - Start Time) for methods
with Scheduled lonization selected, in the Dwell Time graph in the sMRM Calculator script
because these transitions are run throughout the run duration.

* The GS2 parameter is not used for acquisition if the APCI probe is used. If an APCI probe is
used to acquire data, then the lon Source Gas 2 (GS2) parameter is not used, even though
a value for lon Source Gas 2 (GS2) is shown in the File Info for the data.

If a user creates a method with a heated nebulizer (APCI) probe, then while the default value
of lon Source Gas 2 (GS2) of 0 is used in the Parameter Settings, the lon Source Gas 2
(GS2) parameter in the method is not available and a value of 0 is shown. The value of 0 is
shown in the File Info for data acquired with the method.

However, if the method used for acquisition with the APCI probe was created with a
TurbolonSpray (TIS) probe, or if the method was created with an APCI probe but the
lon Source Gas 2 (GS2) had a non-zero value set in Parameter Settings, then the lon
Source Gas 2 (GS2) value shown in File Info is the lon Source Gas 2 (GS2) value set
in the TurbolonSpray (TIS) probe method or the lon Source Gas 2 (GS2) value from the
Parameter Settings.

To prevent any issues, we recommend that methods be created after the hardware profile
with a heated nebulizer (APCI) probe is activated, and that the lon Source Gas 2 (GS2) field
be set to 0 in Parameter Settings. The lon Source Gas 2 (GS2) value in File Info would
always be 0. If a non-zero value is set in the Parameter Settings, then the lon Source Gas
2 (GS2) field that is unavailable in the acquisition method would also have a non-zero value,
although this field is not used. (AN-3389)

* Delay Time behavior in an MRM scan is different from a Scheduled MRM (sMRM) scan:
For a period that contains dynamic scans such as a Scheduled MRM (sMRM) algrorithm
experiment, a scan using DFT, or IDA experiments, the delay time should be less than
the period duration. The MS acquisition duration is the Duration minus the Delay Time
in minutes, and the MS period duration is the Duration. For a period that contains only
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non-dynamic scans such as one or more MRM experiments without being looped with a
Scheduled MRM (sMRM) or a scan using DFT or an IDA criteria, the MS acquisition duration
is the Duration, and the MS period duration is the Duration plus the Delay Time in minutes.

Compound Optimization is only supported in local acquisition and not in network acquisition.
(AN-3591)

Scheduled MRM (sMRM) algorithm experiment limit:

For SCIEX 3200 systems, SCIEX 4000 systems, and APl 5000 systems, to maintain optimum
system performance, a Scheduled MRM (sMRM) algorithm, non-IDA experiment should not
exceed 1,000 transitions and three dependent parameters. A Scheduled MRM (sMRM)
algorithm, IDA experiment should not exceed 1,000 transitions and two dependent
parameters. If the experiment exceeds these limits, then the Analyst software might stop
responding and the user must restart the instrument and reactivate the hardware profile.
Reduce the number of transitions to increase the number of dependent parameters.

For all the other series systems, the limit is 4,000 transitions with three of the four dependent
parameters (CE, DP, EP, CXP).

For successful acquisition, make sure that the file path to the Acquisition Methods folder
is 128 characters or less. Also, to save the batch, make sure that the batch file path, which
includes the dab extension, is less than 128 characters.

Analyst Reporter

As of Analyst 1.7.3 HotFix 2, the analyte grouping behavior in the Analyst Reporter has
changed. If analytes are to be included in same analyte group, then the analyte names

must end with a space and then an integer. Characters from the start of the analyte name

to immediately before the last space character must be the same. Analyte names have
always been case sensitive. Thus, "Morphine 3" and "Morphine 4" are put in the same group,
and "Morphine Dihydro 1" and "Morphine Dihydro 2" are put in the same group. However,
analytes with names such as "QAXL 357 1" and "QAXL 225 2" would not be put in the same
group. To put these analytes together, the user must give the analytes a different name.

Before, if analytes belonged to different analyte groups, they had names that started with the
same characters, and a minimum of one analyte had a name that ended in " 1", then the
analytes were put in the same group. For example:

* Morphine 1

* Morphine 2

* Morphine Dihydro 1
* Morphine Dihydro 2
(AN-1645)

The Print Automatically function in Analyst Reporter does not print HTML reports. If Analyst
Reporter is used to create reports and the output format Html is selected, then do not select
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the Print Automatically check box. Although an HTML report can be created successfully,
the Print Automatically function does not operate because of limitations in the Windows 10
operating system. To print documents automatically, select the Word or Pdf output format.

If the output format is PDF and Print Automatically is selected, then make sure that Adobe
Reader is set as the default program to open pPDF files. (AN-3279)

Audit Trail

+ If special characters or non-English characters are in a batch file name, file path, or the
Analyst Root Directory path or folder, then the error message **Error** UNABLE TO
DISPLAY CONTENT - Invalid file path is shown in the Change Description column
for the related audit trail records under Audit Trail Data in the Audit Trail Manager.

To see full content of the records for the quantitation audit trail, click the Show Audit Trail

icon (| B ), which is found on the toolbar when the Results Table is open. If required, to print
the quantitation audit trail records, click File > Print. (AN-1526)

+ To make sure that all audited events are recorded in the Audit Trail, the users logged on
to Microsoft Windows and to the Analyst software must have Modify, Read & execute,
List folder contents, Read, and Write access to the APTI instrument folder. The user
who logs on to the Analyst software must also have Modify, Read & execute, List folder
contents, Read, and Write access to the applicable project folders.

To make sure that the “Unsuccessful user login attempt as Domain\user” event is written
in the Audit Trail, users who log on to Microsoft Windows must have the following rights:
Modify, Read & execute, List folder contents, Read, and Write. To show who tried to
log on to the Analyst software, the name of the user who logged on to Microsoft Windows
is written in the User Name column for the event in the Audit Trail because the Microsoft
Windows user is used to write this event.

A user that logs on to the Analyst software must have the following rights to the API
Instrument folder: Modify, Read & execute, List folder contents, Read, and Write, for

the “User successfully logged in” and “User successfully logged out” events to be written in
the Audit Trail. The name of the user who is logged on to the Analyst software is used to write
these audit events. (AN-3550)

CAUTION: Potential Loss of Data: Acquire data to a local drive. In the case of
network data acquisition, there is the possibility of loss of data integrity if the network
connectivity is interrupted during acquisition.

* Do not add or delete the Analyst software files with File Explorer. Such an event is not
audited by the Audit Trail in the Analyst software. (AN-967)

* Do not create a project with the name API Instrument on a network root directory. Doing
so causes instrument audit trail events to be recorded in the API Instrument project on the
network instead of the local API Instrument project. (AN-2290)
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In the Audit Map Settings for the Instrument Audit Trail, the following events, even if they are
selected in the Audited column, are not used to audit events related to the Resolution Table
or Calibration Table in the Analyst software:

* Resolution Table(s) replaced
* Resolution Table added

* Mass Calibration Table and Resolution Table changed

Instead, the following four events are used for auditing the events of adding or changing the
Resolution Table or Calibration Table:

* Resolution Table replaced - No Prompt

This event is used to audit Resolution Table changes using any method and to audit the
printing of the Resolution Table.

» Mass Calibration Tables replaced

This event is used to audit Calibration Table changes made ONLY in the editor and to audit
the printing of the Calibration Table.

* Mass Calibration Table added
This event is used to audit when a new Calibration Table is created.
* Mass Calibration Tables replaced - No Prompt

This event is used to audit the Calibration Table changes made through all the other
methods other than those previously stated.

Therefore, the use of the Full Audit Map for the Instrument Audit Trail, whether or not the
Full Audit Map triggers an E-signature for the Calibration Table change, depends on how
the changes were made, that is, in the Instrument Data Editor, by Instrument Optimization,
through the Analyst Access Object (AAQ), or in the advanced calibration table. A change to
the Resolution Table, however, does not trigger an E-signature.

The wiff and corresponding wiff.scan files are considered to be one data file and the file
names must be identical. Do not rename part of the data file. Changing part of the data file
name prevents the Audit Trail from recording the event correctly when a user attempts to
open the data file. (AN-1370)

Make sure that there is sufficient empty space on the C: \ drive for the audit trail for the
Analyst software to function correctly. If the drive is full, then the audit trail might show 0
records, depending on the audit trail (atd) file size. If the C: \ drive becomes full, free up
some space, and then the audit trail will show all of the records. (AN-1722)

On a computer configured with the Windows 10 operating system, if the user who logs on
to the Analyst software in Mixed Mode is a different user than the user who is logged on

to the computer, then the Audit Trail record printing function is not available. The Windows
10 component that the Analyst software uses to print has a known limitation that prevents
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different users from printing. In addition, opening the Analyst software as a different user in
Integrated Mode or Single User Mode is not supported. (AN-1358)

» The audit map for a Results Table has a different Modified date and time than the Modified
date and time shown under the Projects node or in a Windows folder. In the Audit Trail
Manager, the audit map associated with a Results Table (accessed under the Results Tables
node) might have a different Modified date and time from its Modified date and time shown
with the project node (accessed under the Projects node) or in a Windows folder. This can
happen with Results Tables created with the factory-installed audit maps (cam files in the
Project Information subfolder). To resolve this difference, in the Audit Trail Manager,
select a project under the Projects node and then open the Settings tab. Select each factory
installed audit map and then click Save. From this point on, the audit map dates and times
for Results Tables created with the audit maps will match the dates and times shown with the
project node.

This issue is applicable to all of the project folders that existed before the upgrade to the
Analyst software 1.6.3, and to the customer-created project folders (project folders other than
API Instrument, Default, and Example) on an installation of the Analyst software 1.6.3
using an existing Analyst Data folder where no Analyst software is currently installed
(Analyst software re-installation). The Analyst software 1.6.3 fresh installation using an
existing Analyst Data folder and the three installed folders, APT Instrument, Default,
and Example, would not have this issue.

* The audit trail Full User Name column has changed.

In the Analyst 1.7.1 Patch for RODC Network, the Analyst software 1.7.2, and the Analyst
software 1.7.3 with or without HotFix 1, the audit trail Full User Name column shows the Full
Name of the user account, as stored in the Windows Server Active Directory. The Display
Name and Full Name of the user account are typically the same, but they do not have to be.
The network administrator can make them different.

However, from Analyst 1.7.3 HotFix 2 and later, the audit trail Full User Name column shows
the Display Name of the user account, as saved in the Windows Server Active Directory,
unless the Display Name field is empty in the Active Directory, in which case the Full User
Name is shown.

Note: The e-mail address of the user (the logon name used for the Analyst software) will
be used in the Full User Name column if the Analyst software cannot get the full name or
display name of the user because there is no access to the network. (AN-2447)

Explore

» File Info has been changed for the VICI Valco 2-position 10-port valve. For data files acquired
in Analyst 1.7.3 HotFix 2 or later, the following updates have been made to the information for
the Valco valve in the File Info:
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» ver has been changed to FW version, and the firmware version of the device is shown
in the FW version field. Previously, the ver field was empty and the firmware version was
shown in the S/N field.

* N/A is shown in the S/N field, because the serial number is not available from the Valco
valve firmware. Make sure to record the device serial number from the hardware label.
(AN-3220)

Method and Batch Files

* When a user who has no rights to overwrite a method or a batch file tries to overwrite a file,
then a new instance of the file is created using the same file name with a number added to
the end of the file name. (AN-2688)

» To import a batch file into the batch editor in the Analyst software, make sure that the number
of columns to be imported is 255 or fewer. The number of characters per data line must also
be no more than 2000 for the imported text file. (AN-1146)

* Multi-period Scheduled MRM (sMRM) algorithm experiments not supported: Multiple period
Scheduled MRM (sMRM) algorithm experiments are not supported in the Analyst software.
Users cannot create methods containing these experiments.

Peripheral Devices

» The Analyst software only supports up to 5 channels, including the reference channel, if
selected, for a 2D or Signal Data mode acquisition using a Shimadzu PDA or an Agilent DAD.
(AN-1796)

» For acquisition using an ExionLC PDA, Shimadzu PDA, or an ExionLC 2.0 DAD, the Analyst
software data stores either 2D data or 3D data depending on whether 3D is selected in the
acquisition method. If 3D is selected, then only 3D data is stored in the data, even if 2D is
also selected in the method. (AN-1148)

+ If the stop time in the Analyst Device Driver (ADD) method is different than the MS stop
time, then the time option for Stop Time must be selected and the desired stop time entered.
Do not use the default option, As Injector/No Limit, even if the gradient is defined in the
Timetable. Otherwise, the LC controlled by ADD stops running the LC method at the MS stop
time. (AN-2586)

* For an ExionLC system that is configured through the Integrated System SCIEX LC
Controller, or a Shimadzu LC-20/30 system that is configured through the Integrated System
Shimadzu LC-20/30 Controller, with the Wait Time set to x (x=0, 1, ....10) on the device,
and the Wait for temperature equilibration before run check box selected in the acquisition
method, the acquisition does not start until the column oven has reached the set temperature
and has then waited for x minutes, when x does not equal 0. This is expected behaviour.
However, the acquisition starts immediately without waiting for the column oven to reach
the set temperature when x=0. This is intentional. Make sure that the system is equilibrated
before a batch is started.
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* LC Help and Analyst software Help: If an LC Help is open, then opening the Analyst software
Help will automatically close the LC Help. If the user needs both Help files to be open, then
open the LC Help after opening the Analyst software Help.

» For LC device methods, the default pump stop time is longer than the default MS stop time.
For any LC pump such as an ExionLC pump, or a Shimadzu pump that is activated through
the SCIEX LC Controller, when an acquisition method is created in the Analyst software,
the pump has a default Stop Time of 10 minutes and the Analyst software MS method is 5
minutes. The LC device method stop time should be adjusted appropriately.

+ Different autosamplers permit different injection volume ranges and precisions. The injection
volume controls the different precisions permitted for each autosampler. If an invalid injection
volume is entered, even if it is in the permitted injection volume range, then the acquisition
does not start as per the LC driver design. For example:

For the ExionLC AC Autosampler, the injection volume setting range and permitted increment
and precision is shown in the following table:

Table 3-1 ExionLC AC Autosampler Injection Volume Setting

Injection volume setting range 0.1 L to 50 uL (standard), 0.1 pL to 100 uL (optional)

0.1 yLto 0.9 pL in 0.1 yL increments, 1 yL to 100 uL
in 1 uL increments)

For the ExionLC AD Autosampler, the injection volume setting range is shown in the following
table:

Table 3-2 ExionLC AD Autosampler Injection Volume Setting

Injection Total injection [ 0.1 pL to 50 pL
volume

setting range 0.1 uL t0 9.9 uL: 0.1 pL increments; 10 pL to 50 pL: 1 L

increments

Loop injection | Select either loop of 5 pL or 20 uL capacity.

0.1 yL t0 9.9 pL: 0.1 pL increments; 10 yL to 20 pL: 1 yL
increments

For a Shimadzu autosampler, refer to documentation that came with the autosampler.

* Inversion 1.7.3, or later, of the Analyst software, the pressure traces from Agilent or ADD, if
enabled, are shown under Explore > Show > Show Auxiliary Traces.

* Do a system check on Shimadzu and ExionLC PDAs to make sure the lamps are still in good
condition. A system check should be done on Shimadzu PDAs and ExionLC PDAs before
data acquisition to make sure that the lamps are still in good condition and do not cause
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poor data. This can be done by directly connecting to Shimadzu modules using the Ethernet
connection and entering the IP address in a web browser, external to the Analyst software.
Starting from Analyst 1.7.3 HotFix 3, batch acquisition will not stop when the system receives
an error message from the LC driver about the PDA detector lamp usage time. A warning
that the PDA detector lamp usage time cannot be updated will be logged in the system Event
Viewer. (AN-3214)

ExionLC Systems

ExionLC autosampler internal rinsing-related issue

In the acquisition method with ExionLC system, if 1, 2, or 3 rinse solvents were selected in
the Internal Rinse settings section, then the internal rinse did not take place. The workaround
was to select 4 solvents to start the internal rinse. Users had to decrease the rinse volume to
compensate for the added rinse time. Also, to start the rinse process, the setting in the Rinse
sequence: RO->None->None->R0 was used. This issue might have occured if the start or end
of the rinse sequence was set to None.

Note: This issue was fixed in the Analyst 1.7 HotFix 3. However, if the same acquisition
method from a version before Analyst 1.7 HotFix 3 is used in Analyst 1.7 HotFix 3 or a later
version, then the retention time shift might be seen between two different versions of the
software.

(AN-1086)

The ExionLC 100 system turns off when it is put in Standby state. The ExionLC 100 system
turns off when the Analyst software puts the ExionLC devices in Standby state, either when
the user clicks Standby or after the batch finishes and the idle time specified in the Queue
Options is reached. This happens only with ExionLC 100 system. The hardware profile might
still be active at this time. To start the ExionLC 100 system, manually turn on the system
again either from the SCIEX LC Controller status dialog or from the LC system front panel.

ExionLC 2.0 Systems

If a cool oven temperature is used, then a setpoint of 5.5 °C is recommended as the lowest
temperature. Do not use the lower safety limit, 5.0 °C, for a set point, because fluctuation to
anything below 5.0 °C will cause a column oven error. The same applies to the upper limit.
Use a set point lower than the upper safety limit, such as 84.5 °C or lower, to prevent a
column oven error.

Make sure that the detector lamps are on and ready before starting acquisition.

If solvent level monitoring is used in the LC Integrated System Detailed Status window, then
make sure that the current volume is correct before each batch acquisition.

When loading the sample trays, make sure to follow the plate layout in the software, or refer
to the document: ExionLC 2.0 System Hardware User Guide.
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» If samples are acquired to the same data file using a method containing a ExionLC 2.0
DAD in a 3D data mode with a high sampling rate, then delays in completing the sample
acquisition might be observed while the data file size increases. This is because the Analyst
software tries to collect all of the data points from the LC driver. As a result, the sample
acquisition might seem to take much longer than the method run time. However, the data is
for the correct run duration. To avoid delays between samples caused by the transfer of a
large number of data points, acquire each sample to a separate data file.

*  When creating an LC method for a system with a DAD, make sure that the wavelength
defined for each channel and each row in the Wavelength program for the 2D data mode is
within the Wavelength range defined for the 3D data mode, even if the 3D data mode is not
selected. For an example error message that is shown when an invalid method is saved, refer
to the figure that follows. The row number refers to the row in the Wavelength program.

Figure 3-3 Invalid ExionLC 2.0 DAD Method Error Message
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» In cases where the computer is shut down or restarted unexpectedly while the hardware
profile is active, the ExionLC 2.0 system might lose communication with the computer. Turn
all of the ExionLC 2.0 system modules off and on to detect them again. (AN-1988)

+ If any of the modules of the ExionLC 2.0 system goes into an error state because of an issue

requiring no physical fix, then the Standby button (®) on the LC Integrated System Detailed
Status window can be used to clear the error. Use this button to turn the LC modules off and
then on again. However, a hardware profile deactivation and activation are still required. In

the rare cases when this recovery approach does not work, deactivate the hardware profile,
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turn off the computer, turn all of the LC modules off and then on, and then turn on the
computer again.

If a batch contains an LC method with the pretreatment option set to Use first destination
vial, then before the batch is run again or the same LC method is used in another batch, the
first destination vial position must be reset. It is automatically reset when the system state
changes to Standby and when the hardware profile is deactivated and activated. The user
can also reset the first destination vial position in the following ways:

1. Click Reset vials (@) in the Autosampler pane of the LC Integrated System Detailed
Status window. Then select Reset destination vials.

2. Submit a batch containing a single sample that uses a different first destination vial
position.

If Use first destination vial (FDV) is selected for pretreatment, then make sure that the
last destination vial position (LDV) is valid for the rack type selected and the number of
samples (n) to be included in the batch. Otherwise, batch acquisition will stop on the
sample with an invalid destination vial number. The destination vial position is always
equal to the destination vial position of the preceding sample, plus 1.

For samples 1, 2, 3, and 4, respectively, the destination vial positions will be FDV,
FDV+1, FDV+2, and FDV+3. If the number of samples to be included in the batch
is 30, with vial positions 11 to 40, and FDV is 51 on a 2 x 48 vial rack, then the
LDV=FDV+n-1=51+30-1=80.

Note: Make sure that a vial is present in every projected destination vial position.

The detector lamp in an ExionLC 2.0 DAD or ExionLC 2.0 Multiwavelength Detector stays on
if the system is left in Idle state after the hardware profile is activated and the system is not
equilibrated or a batch is not acquired. To extend the detector lamp life time, do not leave the
system idle for a long time immediately after activating the hardware profile. Either equilibrate
the system or put the system in Ready state, and then let the system go to Standby state
manually or automatically. (AN-2202)

The software driver for the ExionLC 2.0 system is not reverted to the version installed by

the Analyst software 1.7.3 after the Analyst 1.7.3 HotFix 1, 2, or 3 is removed. When the
Analyst 1.7.3 HotFix 1, 2, or 3 is removed, the ExionLC 2.0 software driver version 1.0.0.91
stays. The driver is not reverted to version 1.0.0.83, which was installed with the Analyst
1.7.3 software. If the ExionLC 2.0 system is to be used with the Analyst software 1.7.3, then
remove the Analyst software 1.7.3 first, and then install the Analyst software 1.7.3. (AN-2910)

Shimadzu Systems

If a plate changer is configured with a Shimadzu LC-40 autosampler, then the 3-plate rack
and the plate changer cannot both be selected in the Rack Code column for different
samples in the same batch. When creating a batch, either use Plate Position 1, 2, or both in
the 3-plate rack, or only the plates in the plate changer. (AN-2074)
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Internal rinsing in a Shimadzu LC system controlled through Integrated System Shimadzu LC
Controller did not work properly in Analyst software 1.6.3 and earlier versions. The defect is
fixed in Analyst software 1.7.3. Expect retention time shifts if an internal rinsing mode is used
for the acquisition methods when they are used in versions of the Analyst software before
and after the fix.

If a plate changer is installed with a Shimadzu LC-40 autosampler, then make sure that Plate
# 3 is not selected on the 3-Plate Rack when saving and submitting a batch in one of the
following ways:

* Through the Analyst software

* Through a vertical application

This plate position is reserved for moving a sample tray from a plate changer to the
autosampler for sample injection and cannot be used for this configuration. (AN-1780)

Shimadzu LC-40 PDA (SPD-M40) data might show small artificial regular spikes using
firmware version 2.00. If firmware version 2.00 is used for the Shimadzu SPD-M40 detector,
then the data might show small artificial regular spikes. The frequency of the spikes or valleys
is related to the sample speed of the PDA method. Make sure to use firmware (ROM) version
2.07 or later for the Shimadzu SPD-M40 detector.

Waters UPLC Systems

To use a Waters UPLC system, install only the Waters DP2022R1 or DP2023R1 on the
workstation with the Analyst software. Do not install the Waters SCIEX CDS Support Layer
version 2.0.0. Installation of the Support Layer causes the autosampler database in the
Analyst software to be overwritten and some of the autosamplers supported in the Analyst
software to become unusable. If the Analyst Device Driver (ADD) software is installed on the
workstation, then autosamplers that are controlled by the ADD software become unusable. If
the Support Layer is installed, then the Analyst software must be installed again.

Quantitation

The Q1 and Q3 masses for the MRM transitions in the quantitation method must be the same
as those in the acquisition method. A wrong transition might be processed for an analyte if
the data file is processed using a quantitation method that was created using a representative
sample acquired with a slightly different acquisition method than the one used to acquire the
data file being processed. For example, this would happen if a specific transition is slightly
different in the quantitation method than in the acquisition method, and if another transition

in the acquisition method is almost the same as this transition in the quantitation method.
(AN-2131, AN-2314)

Possibly, for the same data set with the same integration parameters, the peak areas
quantitated using Analyst 1.7.3 HotFix 1 or later might have a minor difference from those
quantitated using the Analyst software 1.7.3 or earlier versions, even if the integration
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parameter values are typical and the peaks show good separation and are well integrated.
The minor difference, if any, is a result of the fix for issue AN-2844. (AN-3350)

* The expected RT is not automatically updated when integration parameters are changed
during quantitation peak review in the Analyst software.

From the Analyst software version 1.7 and later, the expected RT is not automatically updated
when integration parameters are changed during quantitation peak review in the Analyst
software. The expected RT entered or selected by the user is kept. (AN-861, AN-869)

* The Review option is not supported when the Results Table uses certain layouts. When an
internal standard is re-integrated, the Review button in the History column for the audit record
for that operation is not available. This feature has been disabled. The Review option is
not supported when the Results Table uses these layouts: Summary, Analyst Group, Sample
Type. A message is shown prompting the user to change to either Full Layout or Analyte
Layout for the analyte of interest. The Review option is also not supported if Peak Review is
configured to review internal standards before all analytes. In this case, Peak Review shows
the internal standard chromatogram and not the analyte chromatogram being reviewed. In
the Peak Review Options, use either Don’t review internal standards or Review with each
analyte. (AN-1103)

* In the Analyst software, when a Results Table is exported as a PDF file, any column with a
cell that contains more than 118 characters will not be exported. Make sure that each field in
the Results Table contains no more than 118 characters. (AN-3337)

* Do not use the Analyst software to process data from a SCIEX 7500 system or SCIEX 7500+
system during acquisition by the SCIEX OS software.
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This section describes the known issues in the Analyst 1.7.4 software.
Audit Trail

The audit trail time stamp for the Results Table changes when the computer time is
changed

When the computer time is changed, the audit trail time stamp for a Results Table reflects the
change. However, the Project audit trail stays the same. (AN-746)

Audit maps and QuantSettings.sdb might get overwritten during a fresh installation

Audit maps and QuantSettings.sdb are overwritten during a fresh installation of the Analyst 1.7
software with HotFix 1, or a later version, using an existing Analyst Data folder. This happens if
the time stamp of these files is before the time stamp of the factory shipped files. (AN-1101)

The audit trail wrongly records that the Analyst Classic algorithm parameters changed
when in fact the MQ Il algorithm parameters changed

When the MQ Il algorithm is used for processing data, the audit trail wrongly records that
Analyst Classic algorithm parameters, such as Area threshold and Noise threshold, were
changed. This does not affect the data in any way. MQ Il was used to process the data.
(AN-403)

Analyst software use in an RDP (Remote Desktop Protocol) environment (that is Citrix)

Accessing the Analyst software using RDP is not recommended. Users who access the Analyst
software using RDP are logged in the Analyst software audit trail. The logons of users at a
workstation that is running RDP are recorded in the audit trail using the credentials of the first
user.

Wrong audit trail information with manual integration

The information in the audit trail is incorrect when the user chooses to revert to the manual
integration results (that is, when Reject Manual Integration is configured). The audit trail record
shows the Change Reason and E-signature even though they are not configured. (SCR 13761)

Audit events are cleared unexpectedly

In the Audit Map Editor dialog, if the user right-clicks the Audited column and then clicks
Fill Down, the Project Settings Have Been Changed and Instrument Settings Have Been
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Changed Events check boxes might be cleared. Do not use Fill Down over these events. (SCR
14266)

Closing the IDA file is not logged as an event in the audit trail

If IDA data file is closed, then the event is not logged in the audit trail. (ST 9487)

The Analyst software stops responding when performing print preview

If the user selects to print preview an audit trail that has more than 100 records using the All
Pages menu option (right-click), then the Analyst software might stop responding. The user can
preview one page at a time using the Current Page menu option instead. (ST 4284)

Audit trail printout columns are truncated

When the user prints the audit trail in both Portrait and Landscape modes, some columns might
be truncated. In some cases, this issue might be minimized by printing in Landscape mode. (ST
2261)

The wrong module is recorded in the audit trail

When the user changes a Quantitation algorithm to another algorithm, the audit trail incorrectly
records the module name as “Build Acquisition Method”. (ST 4922)

An error occurs during printing of a large audit trail

Printing the audit trail from the active Results Table (Tools > Audit Trail > Show) might cause
an error if there are more entries in the audit trail than can be printed on a single page. Print
audit trails only from within the Audit Trail Manager (Menu Bar: View > Audit Trail Manager ).
(ST 6374)

Network time is used for audit events on a network server

When writing audit events to a project residing on a network file server, the audit information
uses the network server clock time instead of the local computer time. This is expected behavior.
(SCR 12390)

Configure — Administration/Security

Error messages are generated when the screen is locked or unlocked and during Auto
Logout in Mixed mode security

In Mixed mode security, when the screen is locked or unlocked during Auto Logout, the
Analyst software generates an error message repeatedly. When the screen is unlocked by an
Administrator or Supervisor user, the same error message is shown, but the screen is unlocked.
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The same error message is shown when the Analyst software logs out the current user after the
time specified for the Auto Logout option has elapsed. (AN-427)

Users cannot enable or disable access to the Unlock/Logout Application feature for a role
in the Security Configuration dialog

On the Security Configuration dialog, access to the Unlock/Logout Application cannot be
directly enabled or disabled. As a workaround, to enable access to Unlock/Logout Application
for a role, enable the whole Analyst Application group if it was disabled, or disable and then
enable the access again for the whole Analyst Application group if it was enabled. Then disable
other individual items again in that group, as required. Similarly, to disable access to Unlock/
Logout Application for a role, disable the whole Analyst Application group if it was enabled,

or enable and then disable the access again for the whole Analyst Application group if it was
disabled. Then enable other individual items again in that group, as required. (AN-1646)

To print a pdf file from the Analyst software, the user must have Delete rights to the
folder where the pdf file is saved

In the Analyst software, if a file such as a Results Table, File Info, or data list is printed to a pdf
file in a folder to which the user does not have Delete rights, then the user gets a message about
not having permission to modify files in the location. If this issue occurs, then do the following.

1. Click OK in the message.
2. Save the file again using the same name.

3. Click Yes to replace the empty file that was created when the file was saved the first time.

This issue cannot be fixed because the function is in the Microsoft SDK and not in the Analyst
software. (AN-2756)

Possible data loss and missing audit trail events after users log off from the Windows
operating system

In Integrated mode, if network acquisition is not set up to use the Special Acquisition
Administrator Account (SAAA), then the user who submitted the batch should not log off

from the Windows operating system until the batch acquisition is finished and the instrument has
gone to Standby. The Analyst software can stay closed.

In integrated mode, when SAAA is not used for network acquisition, with the instrument being
in Standby state, if the user submits batches, starts sample acquisition to the network, and then
logs off from Windows before the instrument goes to Standby, then samples appended to an
existing data file causes data to be lost for the samples that were already in the data file before
the samples were appended. The data loss and checksum error occur when the data files are
synchronized with the ones on the network. Also, the project audit trail event for Sample: ‘x’
has been added to Data File ‘Y’ is not recorded for all samples acquired from the time that the
user logs off from Windows until the instrument goes to Standby. The issue affects the following
workflows:
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» After a batch is submitted with samples to be acquired to different existing data files, or
multiple batches are submitted to be acquired to different existing data files, the user logs off
from Windows before the instrument goes to Standby. For any data file that has a different
file name from the one that was under acquisition immediately before the user logged off from
Windows, and that has samples appended after the user logged off from Windows and before
the instrument went to Standby, the samples that were already in that data file before the
samples were appended are deleted.

*  While the queue is in waiting or acquiring state, the user logs off from Windows and then any
user logs on to Windows and then the Analyst software, and then submits any batches to an
existing data file on the network. The samples that were already in the data file before the
new samples were appended are deleted.

* This issue does not occur in Mixed mode even if SAAA is not used, if the software was not
changed to Mixed mode while the system was still in waiting or acquiring mode. However, in
Mixed mode, for any batches submitted after the first user logs off from Windows and before
the instrument goes to Standby, after the batch acquisition is completed, the Analyst software
must be closed and started again for the data to synchronize to the network location.

To avoid the issues of data loss, checksum error, and missing project audit events, either use
SAAA or use Mixed mode. If neither SAAA nor Mixed mode can be used, then while samples
are waiting in the queue, do not log off from Windows until the system goes to Standby state.
(AN-3428)

The software window might resize upon activating a hardware profile with an LC system

When using a high-resolution monitor, the software window might resize upon activating a
hardware profile with an LC system. This might affect viewing the LC detailed status information
and LC method content in the Method Editor. Should this issue occur, change the monitor
resolution to a lower setting In most cases, dropping the resolution to 2048 x 1152 or 1920 x
1080 can resolve this issue. For SCIEX- supplied monitors, the recommended resolution is 1920
x 1080. (AN-2699)

User names must not contain spaces

Although Windows supports the use of user names containing spaces, the Analyst software
does not. If, in Mixed mode security, a user tries to log into the software with a user name
containing a space, then the Analyst software shows an error and the login fails. (AN-50)

Managing Windows operating system file permissions

To use the Analyst software to manage Windows operating system file permissions, give the
Administrator of the Analyst software change permission for the project folders, including any
network-based project folders.
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Stopping the AnalystService

Only Windows Local Administrator group members are allowed to stop the AnalystService (the
Acquisition part of the Analyst software). If other users need to stop the service, then refer to the
Microsoft Management Console for configuration instructions. Alternatively, users can restart the
computer.

Method Editor access

Users must have read and write permissions for the Project Information folder to access the
Method Editor. If users who have read-only permission try to open the Method Editor, then the
system might stop responding. (SCR 8037)

Mapped network drives might not be visible in Mixed Mode

When the user sets the root directory in Mixed Mode security environment of the Analyst
software, the Browse for Folder dialog does not always show the mapped network drives. This

is because drives that are mapped in Windows is per user. A network drive mapped by user

A can only be seen by user A, and a network drive mapped by user B can only be seen by

users B. Use the computer name in the (Universal Naming Convention (UNC) format (\\computer
name\drive name) instead of the mapped letter. (SCR 11094)

The Analyst software does not start if the user has no file permissions

Users cannot start the Analyst software if the root directory is set to a network drive for which
no file permissions were set for the user. If the user trying to log on is an Administrator, then the
Analyst software prompts for an alternate root directory. (ST 9836)

The screen lock wait time is incorrect in the audit trail

In the audit trail data, the wait time recorded for the Screen Lock in the Security Configuration
is incorrect. Also no audit record is created when the wait time for the Screen Lock and Auto
Logout fields are modified. (SCR 12935)

Issue deleting user-defined role

Before deleting a user-defined role, first remove all users assigned to this role. If the users are
not removed, then the results might not be shown properly.

Unlocking the Analyst software using the UPN name format causes an error

If a user who was not logged on to the software when it was locked attempts to unlock the
Analyst software using the UPN format, then the Analyst software shows an error stating that the
user is not recognized, even though the user has unlocking rights. This happens even if the new
user is a legitimate user in the domain. To unlock the software, click OK in the error dialog and
type the credentials a second time (in UPN format).
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Disabling access to Select processing algorithm does not take effect

Although access to the Select processing algorithm to retrieve peak list function is disabled
for Explore mode for a user role, the user with this role can still modify the integration algorithm
for retrieving the peak list.

The Find tab cannot be activated in Help

Only the Windows Local Administrator or equivalent can activate the Find tab in the Help for the
first time after installation. Otherwise, the software shows the message “Unable to display the
Find tab (177)". (SCR 13792)

Screen lock settings are not retained on reinstall

After the Analyst software is installed, the Network Acquisition account screen lock settings are
not kept. Configure these settings on the Security tab of the Security Configuration dialog.

Configure — Hardware Configuration

An incorrect profile is shown in the error message

An incorrect profile might be shown in the error message when a hardware profile fails to
activate (SCR 13820)

An incorrect value is shown for the DuoSpray ion source Switching Valve Counter value

During IDA acquisition, the value in the DuoSpray ion source Switching Valve Counter field in
the hardware profile is incorrect. (SCR 13635)

Temperature Reached might be shown intermittently while the Turbo V ion source is
cooling

If the temperature of the Turbo V ion source is set to a value lower than the current setting, the
ion source might intermittently report “Temperature Reached” while it is cooling. Users should
allow the system to cool or stabilize for the recommended time while the source is cooling. (TT
35398)

Deactivate hardware profile error message is shown during uninstall

Occasionally, during removal of the Analyst software, a message asking the user to deactivate
the hardware profile is shown, even if the hardware profile has been deactivated. To resolve this
issue, restart the computer and then remove the Analyst software. (ST 16060)
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Tune and Calibrate — Compound Optimization

On SCIEX 3200 systems, the Compound Optimization report incorrectly shows the CEP
parameter

The report that is generated as a result of Compound Optimization incorrectly shows the CEP
parameter under the CE parameter. The CE parameter should read as CE. (AN-219)

Total sample volume does not update when the total number of injections is changed in
the FIA (Flow Injection Analysis) source parameters in Compound Optimization

When one or more parameters are selected for optimization and the number of replicate
injections for each parameter is changed, the Total # of injections is updated correctly.
However, the total Sample Volume does not update and stays 0 pyL. (AN-610)

Transitions with the same name might not optimize correctly during Compound
Optimization

When using the automatic Compound Optimization option, use a different name for each
transition to be optimized. If the same name is selected for more than one transition, then some
parameters are not optimized correctly for the duplicate transition. (SCR 9450)

Use of Shimadzu and Tempo MDLC devices when performing infusion Compound
Optimization prevents optimization

The software will not optimize if the Shimadzu and Tempo MDLC devices are included in the
hardware profile. Remove them from the hardware profile before performing this operation, or
create a second hardware profile that includes only the mass spectrometer to be used for
infusion Compound Optimization.

The Compound Optimization report shows that DP is ramped between 0 V and 400 V

On SCIEX 5500 systems, the actual range for the DP ramp used during the optimization is 0 V
and 300 V. (ST 9248)

Compound Optimization does not start the integrated syringe pump for an API 3200
system

Users can start the syringe pump using Manual Tuning or they can use an external syringe
pump. (ST 11130)
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Tune and Calibrate — Instrument Optimization

The software cannot change to Tune mode

After performing Instrument Optimization, the Analyst software might not be able to change to
Tune mode. The Tune button on the toolbar might be disabled. If this occurs, deactivate the
hardware profile and activate it again, and then change to Tune mode. (ST 7002)

Empty subfolders are created in the Instrument Optimization folder

Empty subfolders are created in Analyst Data\Projects\API
Instrument\Data\Instrument Optimization if Instrument Optimization is cancelled on
the final page of the wizard (instead of clicking GO!). (ST 3767)

Additional 1 Da on Results graph

When the user is viewing the results summary, the graph shows an additional 1 Da on either
side of the X-axis. This does not affect the accuracy of the graph. (ST 3775)

Click More Options to see more tuning options

On the Select the scan mode screen, clicking More Options allows the user to set additional
Instrument Optimization parameters. This does not pause the Instrument Optimization wizard
and the wizard can continue while this screen is open. (ST 3763)

Instrument Optimization stops responding when the Start Over button is pressed

Occasionally the Analyst software stops responding if the Start Over button is pressed after
Instrument Optimization is run several consecutive times. Restart Instrument Optimization from
the Analyst software Navigation bar instead of using the Start Over button. (ST 8029)

On rare occasions, the Queue Manager is inaccessible after Instrument Optimization is
run

To correct this issue, deactivate the hardware profile, close and then open the Analyst software,
and then activate the hardware profile. (ST 9678)

Instrument Optimization fails to run after installation

Occasionally, after the Analyst software is removed and reinstalled, Instrument Optimization
fails to run and returns the error, “The current hardware profile is not supported by Instrument
Optimization.” To run Instrument Optimization, remove the Analyst software again and then
reinstall it.
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Correct masses are occasionally not selected when the Alternate Tuning option is being
used

If Instrument Optimization is used to tune a system, then it is recommended that the approved
tuning solution be used. If an unapproved solution is used, then some masses might not be
correctly calibrated.

Occasionally, calibration shifts are observed after optimization of the 12,000 Da/s scan
speed on the SCIEX 5500 system using Instrument Optimization

If this occurs after Instrument Optimization, then either restart the optimization process or
manually calibrate the masses that are out of calibration.

Occasionally, Instrument Optimization becomes unresponsive during tuning

If this happens, do not close or reopen the Analyst software. Use the Task Manager program to
close Instrument Optimization and then start Instrument Optimization again. (ST 13044)

Typing a negative value for the lonSpray voltage (IS) in Negative mode causes the
optimization to fail

When running Instrument Optimization in Negative mode, type IS as absolute (positive) values.
(ST 3778)

Data quality is poor during Instrument Optimization tuning

Occasionally, the Analyst software scans fewer than the number of MCA scans selected in an
acquisition method. For example, the software only returns 3 scans for a Q1 scan when 10 MCA
scans are specified. This MCA issue might affect Instrument Optimization. If this occurs during
Instrument Optimization, then start the optimization process again. (ST 13460)

Tune and Calibrate — Manual Tuning

Updating resolution on-the-fly during data acquisition using a Scheduled MRM (sMRM)
algorithm acquisition method in Manual Tuning causes the Analyst software to stay in
acquisition mode

When an acquisition method with the Scheduled MRM (sMRM) algorithm is being run in Manual
Tuning without the Q1/Q3 Resolution option selected, the sample acquisition or the queue
cannot be stopped if the user changes the resolution settings on-the-fly on the Resolution tab.
The computer must be restarted to regain the communication. To avoid this issue, do not change
the resolution settings while an acquisition method with the Scheduled MRM (sMRM) algorithm
is in progress in Manual Tuning. (AN-1071)
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The Analyst software closes unexpectedly and the Tunedata. tun file is truncated after
the user enters an invalid search range in Edit Tune Peak Parameters

The Analyst software closes unexpectedly after the user enters an invalid search range in Edit
Tune Peak Parameters and the Tunedata. tun file size gets truncated. The reference table is
cleared. If this occurs, restore a previously backed up Tunedata. tun file. (AN-497)

Poor mass calibration can lead to inaccurate MRM cycle time in systems (Not applicable
to the SCIEX 3200 systems, SCIEX 4000 systems, and API 5000 systems)

When the mass calibration of the mass spectrometer is significantly off, users might see effects
such as a significant difference between the observed cycle time in the data file and the
expected MRM method cycle time. (AN-411)

The user is unable to paste a mass table in Manual Tuning for all scan types

Without the Method Editor open, the user cannot paste copied cells or rows from an Excel
spreadsheet to the mass table in Manual Tuning. The workaround is to keep the Method Editor
open, and then paste the copied content in the mass table in Manual Tuning. (AN-980)

GS2 is available when the APCI probe is in use (SCIEX 3200 systems only)

When the APCI probe is installed, the GS2 parameter is available, but should not be. When
using the APCI probe, set and leave the GS2 value at 0. (SCR 14506)

View of metrics for mass calibration

Metrics for mass calibration do not show all the masses used if the calibration peak list is not in
numerical order. (SCR 8483)

Instability in Manual Tuning

If the Graph Information pane is open in Manual Tuning, then the system might stop responding
if one run is terminated and a new one started. Closing the Graph Information pane might
prevent this issue. (SCR 8879)

TIC data might be incorrect when parameters are ramped using a negative step size

Ramp parameters with a positive step size only. Negative step sizes might yield incorrect TIC
data.

Offset drop from unit resolution for the API 3200 system

For the API 3200 system, when tuning, set the correct Offset Drop from Unit Resolution values
in the Tuning Options Resolution tab.

* In the Low Resolution group, in the Offset Drop from Unit Resolution box, type 0.03.
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* In the Open Resolution group, in the Offset Drop from Unit Resolution box, type 0.5.

The syringe diameter does not change during acquisition

On SCIEX 5500 systemes, if both the syringe pump diameter and flow rate are changed while the
syringe pump is running and then Set Flow Rate is clicked, then the flow rate changes but the
diameter does not. Stop the pump and then restart it for the changes to be applied. (ST 8291)

Data is not being recorded for the same number of cycles as requested when MCA is
selected

Occasionally, the Analyst software scans fewer than the number of MCA scans selected in an
acquisition method. For example, the software only returns 3 scans for a Q1 scan when 10 MCA
scans are specified. To correct this issue, restart the scan or toggle between scan speeds and
then restart the scan. (ST 13460)

Windows are not refreshing in Manual Tuning

In Manual Tuning, the user interface is not refreshed when the Resolution Table Editor is moved.
Click between the tabs to refresh the user interface. (SCR 9327)

A syringe pump error does not clear if it is ignored

On SCIEX 5500 systems, when the syringe pump reaches the stop, a syringe pump error is
shown. If the error is ignored for an extended period of time, and the user continues clicking
through the Analyst software, then the error will return but the user might not be able to

clear it because the Clear Error button might be unavailable. To clear the error and regain
communication with the syringe pump, deactivate and reactivate the hardware profile. If the error
is not cleared, then restart the computer. In rare cases, the user must deactivate the hardware
profile and then restart the computer and the mass spectrometer. (ST 9880)

Visible graphs might be slow to update when the 12,000 Da/s scan speed is being run in
Manual Tuning

When the 12,000 Da/s scan speed is being run in Manual Tuning, the graphs that are shown
can be slow to update and the Analyst software might seem to stop responding. This often
occurs if the user changes applications and then changes back. However, the data is collected
successfully and the program updates when the scan stops.

On QTRAP 5500 systems, masses greater than 1,000 Da can be entered in the Isolation
and Excitation tables

Although the mass range for the linear ion trap is 50 Da to 1,000 Da, the software allows the
user to enter values for masses greater than 1,000 Da in the Isolation and Excitation tables. The
effect of entering additional rows for masses above 1,000 Da is unknown but will likely affect
the quality of data for the entire mass range and users are encouraged to avoid doing this. (ST
11622)
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On QTRAP 5500 systems, after a fresh installation of the Analyst software, reference
tables might appear empty

To avoid this issue, activate a hardware profile before attempting to edit a reference table. (ST
8788)

Acquire — IDA and IDA Method Wizard

A manually created information dependent acquisition (IDA) method cannot be saved if a
copied survey scan experiment is changed to a dependent scan

The user is unable to save an IDA method if an IDA dependent scan was created by copying an
experiment from a survey scan and then changing it to a dependent scan. The workaround is to
create an IDA dependent scan by adding an experiment. (AN-1038)

IDA selects ions that do not match the isotope ratio criteria

lons selected by IDA for dependent scans might still get passed even if the ion does not meet
the ion ratios specified. (AN-260)

If there are two EPI scans in an IDA method, only the second EPI scan passes to the MS3
scan

If an IDA method uses two Enhanced Product lon (EPI) scans, then the most intense ion in the
combined EPI scan should pass to the MS3 scan. Instead only the second EPI scan is passed to
the MS3 scan. (AN-157)

Changing the EMS mass range by using the Back button in the IDA Method Wizard might
result in overlapping mass ranges

If the Back button is used to modify the EMS mass range in the IDA Method Wizard, then the
created method might have overlapping mass ranges for EMS survey scans. If the Back button
is used to modify the EMS mass range, then manually correct the produced method for the EMS
mass ranges. (AN-705)

MS3 isolation always uses the new LIT resolution table

In the IDA Method wizard, although the choices for the Resolution Q3 field (High, Unit, Low,
and Open) are available for the MS3 scan type, the MS3 scan type always uses the LIT
resolution table for Resolution Q3. The choices available for Resolution Q3 are ignored. (SCR
11378)

Set to never Exclude Former Target lons from IDA

If a quadrupole mass spectrometer profile is activated in the IDA wizard, then select the For 0
secs option to set the Exclude Former Target lons on the IDA Critera page to Never. (SCR
11762)

Release Notes Analyst Software 1.7.4
RUO-IDV-03-0236-H 51/97



Known Issues

IDA is not triggering on specific charge state

In the second level IDA, MS3 can be triggered by an ion of an unknown charge state even
though the charge states are specified as the criteria at this level. (SCR 11551)

DP and CE values are not stored in the final method

When IDA methods including MS3-dependent scans are generated using the IDA Method
wizard, DP and CE values specified for the survey and other dependent scans are not applied
to MS3 experiments. Type DP and CE values for MS3 experiments in the Acquisition Method
Editor after creating the method. (SCR 12463)

Doubly-charged ions are sometimes incorrectly recognized as singly-charged ions

Doubly-charged ions are sometimes incorrectly recognized as singly-charged ions in an EMS
survey scan of an IDA experiment. (ST 14677)

Singly-charged masses are occasionally misidentified

In IDA experiments, singly-charged ions are occasionally identified as undefined charges. (ST
17100)

Undefined charge states are sometimes incorrectly recognized as singly-charged charge
states

Undefined charge states are sometimes incorrectly recognized as singly-charged charge states
in an EMS survey scan of an IDA experiment. (ST 17100)

In an IDA method, if a dependent scan experiment is deleted, then an additional mass
range might be added to the survey scan

Refreshing the user interface by clicking in a different field, switching between the experiments,
or saving the method, deletes the added mass ranges. (ST 17047)

On the QTRAP 5500 system, ER scans in IDA methods must have a mass range less than
1,000 Da

When the user creates an IDA method with a quadrupole survey scan and a confirmation scan
(Enhanced Resolution), the method cannot have a survey quadrupole mass range greater than
1,000 Da. The user will be prompted to decrease the mass range or remove the confirmation
scan.

On the QTRAP 5500 system, occasionally this message is shown: “No dependent
parameters are found in the IDA method the file will open using Explorer” when opening
non IDA samples in data files collected at 12000 Da/s

The data file opens normally, so the message can be ignored. (ST 13169)
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Survey scan mass ranges are duplicated when users create an IDA method using the IDA
wizard

To prevent this issue from occurring, do not go back to previous pages in the wizard.
Alternatively, delete any duplicate ranges in the final method. (ST 17059)

On the SCIEX Triple Quad 5500 system, the IDA Method Wizard does not allow the user to
select RF/DC scan rates

The RF/DC scan rates are currently unavailable in the wizard. The final method that the wizard
creates uses the preset scan speed of 200 Da/s. This method is editable and can be saved with
the new scan speeds. (ST 9272)

On the SCIEX Triple Quad 5500 system, mass shifts of up to 1 Da might be observed for
data generated using the IDA Wizard

When a method is created with the IDA Wizard, the scan speeds are not available for selection.
However, the scan time is available and editable, and is populated in the final method. The final
method defaults to 200 Da/s. However, the specified scan time might not correspond to this scan
speed. As a result, data collected with these methods might result in an observed mass shift

in the data. To overcome this issue, select a different scan speed, or, to use the 200Da/s scan
speed, select a different scan speed, change back to 200 Da/s if required, and then save the
method before running it. (ST 19703)

Looping opposite polarity EMS experiments as survey scans in an IDA experiment
sometimes causes dependent data to not be triggered

The following scenarios prevent dependent data from being acquired:

+ EMS+ve > EMS-ve > ER > IDA Criteria > Dependent scans

+ EMS+ve > EMS-ve > IDA Criteria where charge state confirmation is selected to NOT
include unknowns > Dependent scans

Therefore, to allow dependent data to be acquired, either remove the ER scan type from

the method or change the IDA criteria to allow acquisition of unknowns. The latter scenario,
however, allows dependent scans to be performed only on undefined charge states. The peaks
with the specified charged states are ignored even if they satisfy all of the other IDA criteria. (ST
17045)

No dependent scans are performed for an IDA method that includes a quadrupole (—ve) >
EMS (+ve) > dependent scan (+ve)

No dependents scans are triggered for data acquired with this type of method with or without
a confirmation (Enhanced Resolution) scan type and with or without “Unknowns” selected for
charge state confirmation. (ST 18132)
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Incorrect ions are selected for a confirmation scan

An IDA method with a Scheduled MRM (sMRM) algorithm scan type as a survey scan and a
confirmation scan type does not work as expected if the intensity threshold in the IDA Criteria
is set to 0. The IDA method selects the ions from a future retention time window for the
confirmation scan during the acquisition instead of the ions that were satisfying all the IDA
Criteria. To avoid this issue, set the Intensity threshold > 0. (ST 18941)

IDA acquisition fails if the hardware profile contains an ADC device

Restart all the peripheral devices and then restart the AnalystService. To avoid this issue, do not
include an ADC device in the hardware profile if IDA acquisitions are performed. (ST 16102)

Acquire — Acquisition Method Editor

The lonDrive Turbo V ion source and the OptiFlow Turbo V ion source were not listed in
the Experiment information

The ion source type for the lonDrive Turbo V ion source or the OptiFlow Turbo V ion source on
SCIEX 5500 systems, SCIEX 5500+ systems, SCIEX 6500 systems, or SCIEX 6500+ systems
is not listed in the printed Experiment information in printed acquisition methods. To avoid any
issues, use File Info instead. (AN-1523)

An acquisition method with 0 duration or 0 cycles might be allowed to be saved

Under a rare workflow, an acquisition method with O duration or 0 cycles might be saved. Make
sure to review the method for the duration or cycles before saving the method. (AN-1199)

Copying and pasting a few cells in a method with the Scheduled MRM (sMRM) algorithm
does not work when the compound-dependent parameters are in the mass table

In a method with the Scheduled MRM (sMRM) algorithm that contains compound-dependent
parameters, when a few cells are copied from the mass table and an attempt is made to paste
the copied content by clicking the first cell in an empty row and then pressing Ctrl + V, two error
messages about invalid compound-dependent parameter are shown and the copied content

is not pasted. To avoid this issue, either copy and paste by selecting whole rows instead of
individual cells or copy by selecting whole rows and then paste by selecting the last empty row.

In rare cases, switching from the Advanced option to the Basic option in a method with the
Scheduled MRM (sMRM) algorithm, then copying one row in the mass table and pasting it
shows the following message: "To copy and paste data from one Mass Ranges table into
another Mass Ranges table, the number of columns as well as the column headings in the
source and destination tables must be the same. Add or remove columns from the destination
table as required." Clicking OK on this message removes all of the existing rows in the mass
table. Try to use one mode for copying and pasting in the mass table, and then switch modes.
(AN-1061)
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The Auto Equilibration option is not working

The Auto Equilibration option in the Acquisition Method Editor is not working. When this option
is selected, the auto equilibration duration should be added to normal step 0 equilibration time,
which lengthens the equilibration time between samples. The auto equilibration duration is not
being considered and the sample acquisition starts as soon as Run is selected. (AN-784)

The user cannot add or delete the last transition for MRM or Scheduled MRM (sMRM)
algorithm acquisition methods

In an MRM or Scheduled MRM (sMRM) algorithm acquisition method with 500 or more
transitions that were added to the method either by copying from a text file or importing from

a csv file, the last row in the mass ranges table might not be blank. In such a case, the

last transition cannot be deleted and new transitions cannot be added after the last transition.
Deleting or inserting at other rows is okay. To avoid this issue, edit one of the cells in the last
row and click elsewhere in the table, which will create a blank last row in the mass ranges table.
After this, the last filled row can be deleted or a new transition can be added. (AN-725)

The Analyst software stops responding when the Edit Parameters button is clicked after a
switch to a different hardware profile

When an acquisition method is open, then switching to a different hardware profile and clicking
the Edit parameters button causes the Analyst software to stop responding. To avoid this issue,
close the acquisition method before switching to a different hardware profile. (AN-117)

The settling time does not update when the scan type is changed from an experiment
with a higher default value to one with a lower value

If within a method the user changes the scan type from one with a high default settling time to
one with a lower default settling time, that field is not updated in the method. Review the settling
time before saving the method. (AN-691)

A Method Editor user interface (Ul) issue occurs when scan type and polarity of a saved
method is modified

If the user opens a previously saved MRM method and then changes both the scan type

and polarity without switching tabs between changes, an error is shown and the method tabs
(Source, Compound, Resolution) are empty. If users are working with saved methods, then they
should change tabs when changing scan type or polarity, to refresh the method Ul. (AN-48)

The filename is lost from the Ul when an existing method that fails validation is saved
again

If after the user opens (or creates and saves) a method, edits the method, and then tries to save
it again, the method fails validation and an error is shown. The filename is no longer shown in
the top of the Analyst software window, and the user is prompted to select a new file name after
attempting to save the method again. (AN-78)
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Different CEM values are not supported for multi-experiment methods with polarity
switching

When creating multi-experiment methods, users can choose to switch polarities between
experiments. If this option is selected, users should not choose different CEM values for the
experiments. If they do, the CEM values are not applied correctly during acquisition. Users
should set the same CEM value for all experiments when using polarity switching. (CBUFW-25)

lonSpray Voltage (IS) values should be the same for all experiments in the same polarity

When creating a multi-experiment method with a single polarity, users should use the same IS
value for all experiments. If users select different IS values, then the voltages are not applied
correctly during acquisition. (CBUFW-25)

Acquire — Method/Batch Editor/Queue Manager

A user logging on to a computer or the Analyst software for the first time might encounter
an error when submitting a batch

When User Account Control (UAC) Settings is set to Notify me only when apps try to make
changes to my computer or a higher level, and a user who is in the security database for the
Analyst software but has never logged on to this computer before tries to log in to the Analyst
software for the first time, then a UAC dialog opens to ask permission to enter data in the User
registry for the new user. Click Yes to continue. However, the project drop-down menu might
appear empty, and the user might encounter an error when trying to submit a batch. If this error
occurs, close the Analyst software, and then start the Analyst software again. (AN-2671)

The Internal Standards column in the Analytes table might auto-populate with internal
standards from other data source

When a quantitation method is created in either Build Quantitation Method or Quantitation
Wizard, the Internal Standards column in the Analytes table might auto-populate with internal
standards from another data source if the Analytes table is filled out before the Internal
Standards table of that data source. The workaround is to deselect the auto-populated internal
standards when there are no internal standards used for the current data source, or select

the appropriate internal standards, if used, in the Internal Standards table before selecting the
analytes in the Analytes table for the current data source. (AN-2601)

The Valco valve might not work properly if it is used with the Analyst Device Driver (ADD)
software

The Valco valve might not work properly if it is used with the ADD software and Manual/AAO
Sync is used for the Synchronization Mode. The issue might be resolved if LC Sync used the
Synchronization Mode. The Sync Cable is required to connect between the autosampler and
the mass spectrometer. (AN-1481)
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Signal loss occurs on the negative EMC spectrum (Not applicable to 3200 QTRAP
systems and 4000 QTRAP systems)

On systems other than 3200 QTRAP systems and 4000 QTRAP systems, signal cutoff might be
observed for some mass ranges in the negative EMC spectrum. (AN-1198)

The user is unable to import batch files in xIs, db, or xIsx formats in the Batch Editor

Importing a batch file in xIs, db, or xIsx format might cause an error and the batch file would not
be successfully imported. The xIsx format is only available in the Files of type list if the installed
Microsoft Office is a 32-bit application. To successfully import a batch file, make sure to save

it as a tab-delimited txt file with the first line starting with ¢ header=SampleName. Refer to

the example file DABImport.txt in the D: \Analyst Data\Projects\Example\Batch folder.
If a csv format is to be used, then edit the file in Notepad and make sure that the first line

is% delimiter="',': and the second line starts with ¢ header=SampleName. (AN-1282,
AN-1234)

The Analyst software cannot write the checksum to a wiff file if the file stays open in the
MultiQuant software or other compatible software

If a data (wiff) file is being acquired to by the Analyst software, do not open that file in the
MultiQuant software or any other application until acquisition has completed. Doing so might
cause the Analyst software to not write the datafile checksum. (AN-305)

Queue: The Next Period button available on the toolbar in the Analyst software does not
work when clicked

When the Next Period button is clicked, acquisition should move to the next period but the
Analyst software remains in the same period even when the button is clicked. (AN-731)

Users should not turn on the SelexlON device during an acquisition

If the user turns on the SelexION device during acquisition, then the currently acquiring sample
is aborted and the system briefly goes to the Error state. When the system recovers to the
Ready state, if users attempt to reacquire their sample, then there is no indication that the
system has changed. Because of this, there might be a mismatch between the status of the
system as shown in File Info and the actual status of the system. Users should refrain from
turning the SelexION device on or off during acquisition. If it is turned on or off, then users
should submit new acquisition batches, rather than using the reacquire function in the software.
(AN-115)

The status of the integrated diverter valve is not updated when the diverter valve position

switches

The status of integrated diverter valve is not updated when the diverter valve position switches,
but the position does switch. There is no impact to the data. (AN-662)
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Show all columns before pasting data in the Batch Editor

Although the Batch Editor supports copying and pasting from and to applications such as
Microsoft Excel, users should be aware that the Batch Editor contains columns that are hidden
by default, for example, Sample ID, Dilution Factor, and so on. When text is pasted from a
spreadsheet into the Batch Editor, all columns are populated in sequence, whether visible or not.
Therefore, it is possible for data to be pasted in an unintended column.

If users want to paste data in to the Batch Editor, then they should manually expose all columns
first, to make sure that data is pasted as intended. Alternatively, users must make sure that the
data they are pasting in the Batch Editor contains information for all columns, visible and hidden.
(AN-216)

The last transition row cannot be deleted in an MRM method with 300 or more transitions

In an MRM acquisition method with 300 or more transitions, the last row of transitions cannot be
deleted. (AN-198)

A filename containing a period and not the file extension is saved with an unknown file
extension and cannot be opened

Do not include a period (.) in the file name because the software considers the information after
the period to be the file type.

This issue occurs during batch creation, when using the Convert Methods script, when saving
the optimization report during Compound Optimization, and when saving the report generated
using the Reporter software. (AN-220)

The Pause Time in a saved method reverts to its default value when the access type for
the CAD gas parameter is changed from Simplified to Operator

The Pause Time in a saved acquisition method changes to the default value of 5.007 ms when
the Access Type for the CAD gas parameter is changed from Simplified to Operator. (AN-266)

Method duration might change when the user changes between tabs

When users change tabs in the Acquisition Method Editor, fields are recalculated. As a result, if

the user sets a method duration and then changes between the Advanced MS and MS tabs, the
duration might change slightly as the number of cycles is recalculated. This results in a method

duration that best fits the number of actual cycles. (TT 34574)

The Analyst software might stop responding if an external valve is configured in the
hardware profile but it is not used in the method

When configuring an external valve in the Hardware Profile, users must make sure that the
valve is assigned a correct switching method in the acquisition method. If users submit a method
that does not contain a valid valve switching method, then the Analyst software might stop
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responding during acquisition. If the valve will not be used during acquisition, then it should be
removed from the hardware profile. (TT 34645)

Number of Scans to Sum might be reset to 1

When using the MCA data collection, if the user sets the Number of Scans to Sum field and
then changes to the Advanced MS tab and back, the field might reset to 1. When using the MCA
data collection, users should set the Number of Scans to Sum field as their last step before
saving the method. (TT 34787)

DFT scans might fail to maintain targets

In some cases, users might see Dynamic Fill Time (DFT) scans overshooting the target intensity.
In these cases, users should switch to fixed fill times. (TT 34872)

Method Editor: Calculated Cycles are not immediately updated

When changing the parameters that affect the method duration, the Calculated Cycles field is
not immediately updated. If users switch to the Advanced MS tab and back, they see that the
field was updated. (TT 34884)

Simulation mode: Some methods might not end at expected times

When running acquisitions in the simulation mode (for example, to test new methods), some
methods might not end at the expected time. The mass spectrometer should never be simulated
for real LC data acquisition. (TT 34893)

Dynamic Fill Time might not work in Manual Tuning

When users run Manual Tuning with DFT enabled, changes to compound parameters might not
trigger DFT to recalculate fill times. Therefore, when running Manual Tuning, users should use
Fixed LIT fill times. (TT 34905)

DBS is not applied when a single MRM is acquired

When an experiment containing a single MRM transition is run, the Dynamic Background
Subtraction (DBS) algorithm is not applied, whether or not the feature is turned on. (TT 35242)

Queue: Waiting samples are treated as Acquired when the Queue stops

When the queue stops (acquisition completed, acquisition error, and so on), any samples that
are in the Waiting state are treated as acquired. If the Queue Options are set to show only a
limited number of completed samples, then these waiting samples might be deleted from the
queue. To avoid this issue, increase the number of completed samples shown in the queue. (TT
35286)
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Queue: The Pause Sample Now icon is not available

The Pause Sample Now icon on the Queue toolbar is inactive and does not affect the
acquisition of samples. (TT 35287)

Sample Details from the right-click menu shows incorrect information

Selecting Sample Details from the right-click menu shows incorrect information (Sample Name,
Status) for samples with the status of Terminated or Partial. Sample details are available for
waiting and acquired samples. To see the correct information for terminated or partially acquired
samples, double-click the row. (ST 31086)

Columns cleared in the Queue Manager cannot be selected again

If users right-click in the Queue Manager, select Column Settings, and then clear the check
boxes, the columns are removed from the Queue Manager. However, the right-click menu is
subsequently not available and the columns cannot be restored to the Queue Manager. To avoid
this issue, do not remove columns from the Queue Manager. (ST 31088)

Moving and then deleting a batch causes the Analyst software to stop responding

In the Queue Manager, if a batch is moved and then deleted, the Analyst software stops
responding. To avoid this issue, delete the batch without moving it. (ST 31098)

Users are unable to delete the last row when the acquisition method contains more than
the maximum limit of MRM transitions

When pasting more than the maximum limit of MRM transitions in the acquisition method, users
cannot delete the last row. Users can delete row n—1 and then edit the last row to include the
information that was just deleted. (ST 6968)

Note: For SCIEX 3200 systems, SCIEX 4000 systems, and API 5000 systems, 300 MRM
transitions are the maximum during acquisition of MRM data and 1000 MRM transitions are
the maximum during acquisition of Scheduled MRM (sMRM) algorithm data. For all the other
systems, 1,250 transitions are the maximum during acquisition of MRM data and 4,000 per
method is the maximum during acquisition of Scheduled MRM (sMRM) algorithm data. (ST
6968)

Copying and pasting acquisition methods

Copying compound-dependent cells that are partially exposed in a mass ranges table might
cause the pasting action to result in an error. Highlight all cells completely (drag the mouse all
of the way to the right) before copying them. Also make sure to copy into the same column for
which the selection has been made, otherwise incorrect data and errors might result.
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Copying and pasting to mass table

For instructions for copying and pasting to the mass ranges table from one acquisition method to
another or from an external file to an acquisition method, refer to the document: Help.

Users are unable to change and save number of cycles

If users edit any previous version of method (dam) files, then they might not be able to change
and save the number of cycles the first time. Repeat the process again to save this information.

Scans are unexpectedly set to sum to 1

If users set the scans to sum to more than 1, clicking the Advanced MS tab and then clicking
the MS tab resets the scans to sum to 1. To store the value properly, type the value and save
without clicking the Advanced MS tab. (SCR 11446)

Column headers are missing in previous versions of batch files

If users open a batch file created from an earlier version of the Analyst software, column
headers might disappear in the Batch Editor. (SCR 11578)

Source/gas information might not reflect values set as default in parameter settings

After creating an acquisition method manually or through the IDA Method wizard, review and
then update the Source/Gas parameters as appropriate. (SCR 11662, SCR 11711)

Users are unable to save or submit batches with long file paths

Users cannot save or submit an acquisition batch if the project path is longer than 126
characters. When this type of file is submitted, the software shows the error message: “Failed to
set Header data”. When this file is saved, the software shows the error message: “Failed to save
BatchName”.

Pasting columns in mass ranges table

Pasting of individual column of values for compound-dependent parameters in MRM and
Scheduled MRM (sMRM) algorithm methods from an external csv or txt file might not always
work. Copy and paste the whole Excel spreadsheet with updated dependent parameter values.

Pasting rows in mass ranges table

Pasting more than 300 lines into an MRM mass table might take several minutes.

Issue with importing file with MRM transitions

Make sure that the imported file is either a txt (tab-delimited text) file or a csv (comma-
separated-value) file. Make sure that the number of columns in the file is equal to the number of
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columns shown in the Method Editor in the Analyst software and that the column order matches.
Also, make sure that there are no empty cells in the file that are imported. (ST 2717)

An error message is shown when a text file is imported into an MRM or
Scheduled MRM (sMRM) acquisition method

When a text file is imported into an MRM or Scheduled MRM (sMRM) algorithm method, the
software might show the message: “Invalid value entered into table. Make sure only numeric
values are entered”. However, the file is imported correctly. This issue is not observed when csv
files are imported or when content is copied and pasted from an external file, regardless of its
format. (ST 19141)

Pasting into a mass ranges table during acquisition can cause the system to stop
responding

When content is pasted into a mass ranges table during acquisition, the Analyst software might
stop responding. Users can only copy and paste into an MRM or Scheduled MRM (sMRM)
algorithm table before and after acquisition.

Switching valve tables must be populated before using method

When using a method containing a switching valve, make sure that the table is populated before
saving and using the method. If this method is used for acquisition, the system stops responding
and you must restart the instrument. (ST 9431)

Pause time doubles if a quadrupole experiment is created after a change between LIT and
quadrupole scan types in the Method Editor

When users create a method containing a quadrupole scan type with a mass range of, for
example, 1,000 to 1,250 Da, and then change to an LIT scan type and then back to the original
quadrupole scan type, the pause time nearly doubles. To prevent the pause time from doubling,
do not change scan types during method creation. (ST 11465)

During batch creation, pressing Tab creates another row

When a batch is created, if the user goes to the last row in the Batch Editor and then

presses Tab, another row is created. After the row is created, the Auto-Increment or Fill-Down
functionality does not work with this row. Also, any rows appended to the batch are shown
before this one. When the batch is submitted, this phantom row is not submitted. If a user
creates a batch with this extra row, the sample specified in this row is not collected. Avoid the
use of the Tab key to add rows to the batch. Use the Add Samples button instead. (ST 14024)

Samples in a batch stay suspended after an instrument error is corrected

The batch must be resubmitted to the queue to continue. (ST 16247)
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lon energy is invalid in EMS scans

Although lon Energy 1 is accessible in EMS scans, it is not applicable and should not be used.
(SCR 11764)

Acquire — Scheduled MRM (sMRM) Algorithm

In certain cases, for the APl 5000 system, sensitivity might be less for
Scheduled MRM (sMRM) algorithm experiments than for MRM experiments

This issue might be observed for experiments covering a wide range of Q1 masses over several
hundred Da. Keep this in mind when using the Scheduled MRM (sMRM) algorithm functionality
on the API 5000 system. (ST 15149)

Batches containing the maximum number of Scheduled MRM (sMRM) algorithm
transitions and three mass-dependent parameters where one of them is EP cause the
system to stop responding

Batches containing the maximum number of Scheduled MRM (sMRM) algorithm transitions and
three mass-dependent parameters, DP, CE, and EP, cause the system to stop responding. To
avoid this issue, do not include EP as one of the mass-dependent parameters. (ST 16066)

Scheduled MRM (sMRM) algorithm parameters cannot be changed on-the-fly

Compound-dependent parameters for an acquisition method using the Scheduled MRM (sMRM)
algorithm might not be applied when changed in real-time in Manual Tuning. When changing
parameters for a Scheduled MRM (sMRM) algorithm method in Manual Tuning under Tune and
Calibrate mode, stop the method between adjustments and then start it again. (ST 9436)

Modifying Scheduled MRM (sMRM) algorithm mass ranges table can take several minutes

Modifying a Scheduled MRM (sMRM) algorithm mass ranges table with 1,000 MRM transitions
can take several minutes. (ST 5251)

Acquire — Network Data Acquisition

Submitting the same batch again for a network acquisition could cause data loss in case
of network disconnection

If a batch has been acquired to a network location, submitting the same batch again using the
same data file names to the same location could cause potential data loss on the samples or
datafiles that were acquired twice. This issue occurs if the network is disconnected during the
acquisition of the second batch. To avoid the issue, do not submit the same batch again, instead,
change the data file names and save it as a different batch, and then submit the batch, just in
case the network gets disconnected unexpectedly. (AN-1310)
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Copy data to a network location before validating the checksum

If the user attempts to validate the checksum of a large file that is being acquired to a network
location, then the Analyst software might stop responding or a failed checksum might occur. This
is because network interruptions might cause a delay in writing the full file to the network. To
resolve this issue, restart the AnalystService and client. Alternately, the file itself might become
corrupted. Make sure that the file has been fully copied to the network location before attempting
to validate the checksum. (AN-202)

Data might be lost during acquisition from multiple instruments to same data file

Do not acquire data concurrently from multiple acquisition workstations to the same network
data file.

Network data security mode

For network data acquisition, use Mixed Mode or Integrated Mode. If Single User Mode is used,
then make sure that the user is a network domain user with read and write access to the project
folder. (SCR 11781)

Current data is not accessible

If network acquisition is used, then users cannot see the acquired data from a remote
workstation until the sample is finished.

No audit trail records are created when the network is unavailable

When the network is unavailable, the data file creation and other non-processing activities
performed during data acquisition only are not recorded in the audit trail database, which

is not accessible. Add steps to the standard operation procedures (SOP) to contact the IT
department regularly if there has been any network interruption during previous data acquisition
processes and to avoid data acquisition during network maintenance work. Users can also
review the Windows application event log for any network disconnection warning events. All
relevant acquisition data is still logged in the data file even if the network is unavailable. (SCR
11648)

Reported Last Sample Finished time is slightly later than the time that acquisition
completed

When data files are acquired to the network, the time reported in File Info in Explore mode for
Last Sample Finished is the time the file was copied to the network, which might differ from
the time of acquisition of the last sample. This is due to the delay when transferring files to the
network. (SCR 9523)
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Verify checksum after the file transfer is complete

When Verify Checksum is clicked on a file that has just finished acquisition, checksum
verification might intermittently fail if the data file transfer to the network is in progress.
Checksum verification works after the transfer is complete. (SCR 11419)

The wait period is long if the user does not have write access

If users do not have write access to a network project and try to open a data (wiff) file, they
might experience a long wait period while the audit trail process tries unsuccessfully to update
the information. (SCR 9906)

File transfers might fail due to limited space on the network

When acquiring data to a network server with user-specific space limitations, the Analyst
software might not be able to detect the remaining space available. As a result, the data transfer
process might fail, but acquisition is not affected. The data remains on the local acquisition
workstation. To avoid this issue, always make sure that there is sufficient space. If the issue
does occurs, make some space available, and then restart the Analyst software. (SCR 11420)

The spectral arithmetic output file is not saved

If the root directory is on the network, select Open the New File Immediately in the Analyst
software in the Output Filename section in the Spectral Arithmetic Wizard—step 4. Otherwise,
the output file might not be saved. (SCR 11746)

Explore

File Info pane saved to PDF file format appears empty when viewed in Adobe Acrobat

Select Save to File from the right-click menu in the file information pane of a data file, then save
the file by choosing the PDF format. The saved PDF file seems to be empty when it is opened
in Adobe Acrobat. To see the contents of the file, open the PDF in Chrome or Internet Explorer.
Alternatively, the file information can be saved in RTF format, opened using Microsoft Word, and
then converted to PDF. The converted file can then be opened properly with Adobe Acrobat.
(AN-2670)

Auxiliary trace data is not populated in Explore in real time after the MS stops scanning

If a sample using a longer LC method duration than the MS method duration is being

acquired with auxiliary trace enabled, and the sample auxiliary data is viewed in real time in
Explore mode, then the auxiliary trace data is not populated after the mass spectrometer stops
acquisition. (AN-2393)
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LC method information might not be displayed properly if the Show Next Sample, Show
Previous Sample, or Go To Sample buttons are used when the File Info pane is open.

If the File Info pane for a data file is open in Explore mode, then clicking the Show Next
Sample, Show Previous Sample, or Go To Sample icon in the top tool bar might cause the LC
method properties to show improperly. The LC method information might not be shown in full,
and some of the period and experiment information might be repeated. If the issue occurs, then
deactivate the hardware profile if it is active, close the Analyst software, and start the computer
again. To avoid the issue, close the File Info pane before clicking these icons in the tool bar.
(AN-1967)

The LC method file name and detailed information are not shown in the Analyst software
File Info for data files acquired with the SCIEX 7500 system or SCIEX 7500+ system.

For data files for the SCIEX 7500 system or SCIEX 7500+ system that were acquired with the
SCIEX OS software, the LC method file name and detailed LC information are not shown in the
File Info in the Analyst software. To view the LC-related information, use the SCIEX OS software
instead. (AN-1933)

Simplified CAD gas settings are shown incorrectly in File Info

If a data file was acquired using simplified CAD gas settings and opened in the Analyst software
without the corresponding hardware profile active, then the CAD gas setting in the File Info is
shown incorrectly. A CAD gas setting of Low is shown as —1, Medium as -2, and High as —3.
(AN-299)

Centroid data is not shown correctly

Centroid data is not shown correctly when scan the user averages scans and steps the
extracted ion chromatogram (XIC) to show the adjacent spectra. Instead of using Centroid, use
Profile scan mode to show the data correctly. (AN-405)

High mass PPG values are shown for SCIEX 5500 systems, SCIEX 6500 systems (low
mass mode), and SCIEX 6500+ systems (low mass mode) in the calibration peak list

On SCIEX 5500 systems, SCIEX 6500 systems (low mass mode), and SCIEX 6500+ systems
(low mass mode), additional ions 1,254, 1,545, and 1,952 are shown in the calibration peak list.
This has no impact on the calibration of the mass spectrometers. (AN-500)

Processing large data files concurrently with long data acquisition

Avoid processing, such as generating an XIC, for a large data file that has more than 600

MRM transitions while performing a long data acquisition. Doing so might cause the software to
become unstable and data to be lost. Use another computer to process such data. When data
currently being acquired is opened, the display for currently acquiring Scheduled MRM (sMRM)
algorithm data defaults to TIC to open the file faster. Processing these files should still be kept to
a minimum during acquisition.
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Processing Options truncates non-integer values

The Analyst software Integration tab on the Processing Options dialog (Tools > Settings >
Processing Options, Integration tab), allows the user to type decimal values between 0 and
100. However, after the screen is closed and then reopened, these values truncate to their
integer values.

The Subtract Range Locked option seems to be active and the menu item in the right-
click menu does not update

When right-clicking on a chromatogram, the feature seems to be enabled whether or not it
actually is. To see if the feature is enabled, use either the Menu bar (Explore > Background
Subtract > Subtract Range Locked) or the Explore Toolbar. If the icon is shown as depressed,
the feature is enabled.

Inability to sort Peak Lists correctly

Occasionally, the Peak List does not sort correctly. To restore functionality, close the Peak List
(deleting the pane) and then open it.

The cursor location does not correspond to the time point of the spectral data

Occasionally, the cursor is incorrectly allowed to be placed between data points. The time in the
header of the spectrum of the active chromatogram is always correct.

Data is missing after an export to the PDF format

When the Analyst software is active with several panes open, exporting the active window to a
PDF file might not export all data from the window. Use Export when there are only a few panes
in the window.

Time range discrepancy for Contour plot

When a processed data file (pdt) is saved with a Contour plot shown, the saved file shows a
different time range than the original Contour Plot.

The X-axis is not extended

After a chromatogram is offset, the X-axis (time) range is not extended to include the shifted
data.

The DAD margin for negative absorbance is not functioning

The diode array detector (DAD) margin for negative absorbance does not function.
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Performance is impacted due to a large number of scans

Processing data can be slow when the data file contains a very large number of scans resulting
from the use of short dwell times. Keep the number of scans below 30,000. (SCR 7964)

Viewing IDA data files

If an IDA experiment data file is opened during acquisition, it is shown in Explore mode even if
the IDA Explorer is set as the default viewer in the Appearance Options dialog. If the data file
is opened after acquisition, it is shown in the IDA Viewer. Samples that were opened in Explore
mode during acquisition do so by default when the acquisition is complete as well. To open the
file again, user the IDA Viewer. (SCR 9805)

The integrated Harvard syringe pump is not in File Info

In some cases the File Info in Explore mode indicates that the integrated Harvard syringe pump
was not used even though it was used. (SCR 8643)

Smoothing does not consider 0 intensity points

The Smoothing function does not consider 0 intensity points. Holes might be visible in the
spectrum after smoothing if there are intensities of 0 in the data file. (SCR 13204)

Show File Info

Opening the File Info pane using the Show File Info command might cause the software to
stop responding or to omit information from the view. This is an intermittent issue and no data

is lost. If this issue occurs, then configure the Audit Trail Manager settings to No Audit Map or
alternatively clear the Closed Module event in the Audit Map Editor to view or save the File Info
to a file. The original audit trail settings should be restored. Only an Administrator for the Analyst
software can configure the audit trail settings.

Overlay on plot for isotopic distribution in calculator

Occasionally, this feature does not function as expected. However, the text is still accurate.

Incorrect status is shown in File Info

On SCIEX 5500 systems, the File Info incorrectly shows the status as “Bad” for the flow of gas
for the Curtain Gas interface and interface pump. There is no interface pump on SCIEX 5500
systems. Also, although the file information will show “Bad” for the flow of gas for the Curtain
Gas interface, this does not necessarily reflect the status at the time of acquisition. If during
acquisition, the flow status for the gas for the Curtain Gas interface develops a true “Bad” state,
then acquisition for that sample will stop with an error. (ST 8853)
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Delays occur in showing the sample list

On SCIEX 5500 systems, it takes more than 90 seconds to populate the sampile list for a data
file acquired with more than 1,000 samples. Allow at least 90 seconds to populate the entire
sample list. If more than 1,000 samples are acquired to a wiff file, then it will take at least 90
seconds to populate the sample list. The Analyst software will be able to open the file. However,
we recommend that the samples be acquired into different data files, if possible.

Syringe pump method is information missing from the File Info

On SCIEX 5500 systems, details about the syringe pump used to collect the data are not shown
in the File Info pane for data where a syringe pump was used. Note which flow rate and syringe
diameter were used during acquisition. Alternatively, the user can obtain this information from
the data file by recreating the acquisition method from the File Info by right-clicking on the File
Info to select Save Acquisition Method. To recreate the method completely, make sure the
hardware profile has the same devices. (ST 7861)

The Explore History file is not shown correctly

The description of all the changes is sometimes merged into one cell but it is often still legible. In
some instances, some information might be missing. (ST 9481)

Changes to the offset in the History pane are not being shown

Open the History pane again to show changes to the offset. (ST 9486)

Reviewing MRM data changes the active XIC

When the user opens a saved Explore History File (eph) from a total wave chromatogram (TWC)
where the data from the mass spectrometer is MRM data, the data is the overlaid XICs but
reviewing the changes switches the active XIC. The listed history, however, is correct and can be
used to manually apply those settings to the original data.

Occasionally, samples in data files collected at 12,000 Da/s cannot be opened

If samples cannot be opened, then open the previous or any subsequent sample and use the
forward and back arrows to navigate to the sample that does not open. (ST 13169)

If data is expanded in the IDA Viewer during sample acquisition to the same data file, data
from an acquired sample is not shown

No data is shown in Explore mode for an acquired sample if the data is expanded from the IDA
Viewer during the acquisition of a second sample to the same wiff file. (ST 18228)
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Undocking the Graph Information Window can cause the software to stop responding

Occasionally when the Graph Information Window is opened and undocked the software stops
responding. This often happens when the window is left open and undocked for several hours
while acquisition and processing take place. To avoid this issue, keep the Graph Information
Window docked. (ST 16700)

The Q1 resolution offset table at 10 Da/s is missing in the File Information

The Q1 resolution offset table at 10 Da/s is missing in the File Information for a negative ER
scan type. This does not affect the data or any future acquisition. To retrieve this information,
look into a data file acquired in Q1 negative mode. (ST 13331)

Sections of ions appear to be missing in EPIl scans

On SCIEX 5500 systems, when QO trapping is used, a fill time of at least 20 ms is required. EPI
spectra acquired with a fill time less than 2 ms will result in a missing range of ions in the second
mass range when QO trapping is On. In general, expect to see an overall decrease in sensitivity
even with one mass range under these conditions. (ST 8200)

Compound Library databases with over 20,000 entries fail to show full information

When the user opens Compound Library databases that have over 20,000 entries, the individual
fields do not show the full information used to populate the original database. The fields are
populated with NA instead. To overcome this issue, it is recommended that the user save the
original database into two separate databases to be able to view all entries and then populate
future entries in a new database. For example, delete the last 10,000 entries and save this
database as “Part 1” and then reopen the original database, delete the first 10,000 entries and
save this database as “Part 2.

Note: Deleting entries and then adding new ones is not recommended. (ST 19297)

The Analyst software stopped responding during real-time XIC data extraction

When large numbers of ions were extracted in real-time during acquisition using an MRM

or Scheduled MRM (sMRM) algorithm method, the Analyst software might have become
unresponsive. This issue has been corrected. However, users should be aware that there might
be cases where extracting large numbers of chromatograms will still cause the software to

slow or become unresponsive. For example, having multiple XIC panes open simultaneously, or
acquiring data from multiple methods to the same wiff file. In these cases, users should refrain
from extracting chromatograms in real-time. (AN-292)

Explore — Library Search

Blank results in new field
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When performing a Library Search from an open spectrum, if the user clicks View Manager from
the Search Results window and adds a new field, then the results for this new field might seem
to be blank. Clicking the field a few times causes the results to be shown. This is a graphical
issue and does not affect functionality.

Hidden column in Compound Library view

When viewing the Compound Library, increasing the width of the last column might uncover a
column named Hidden, with populated values. This is a graphical issue and does not affect
functionality. Do not modify the data in this column. (ST 3165)

Editing the compound name twice might cause the Analyst software to stop responding

If the user edits the name of a compound in the library, clicks OK, and then attempts to edit
the compound again, the Analyst software stops responding. To avoid this, after clicking OK to
change the compound name, close and then open the library before attempting to change the
same compound. (ST 2283)

Opening a library record in the default library might show a blank spectrum

If this occurs, then reconnect to the library database (Tools > Settings > Optimization Options
> Library Manager ) to correct the issue. (ST 1860)

Explore — wiff Data File

Analyst software file compatibility

The Analyst software is fully backward compatible. However, it is not forward compatible. That
is, the data files acquired in an older version of the Analyst software can be opened in the newer
version of the software, but not vice versa. If the acquisition computers are upgraded to the
newer Analyst software, also upgrade the processing computers to the same version.

Flat file size limit

The software can show data in the flat file (wiff.scan) for files up to 2 GB in size. Any data stored
beyond this limit might not be shown correctly. In addition, larger file sizes might degrade overall
performance. Begin acquiring data to a new data file if the file size nears this limit (for example
at 1.5 GB).

Quantitate

"Acquisition Methods" is shown as the acquisition method file name in the Results Table
and reports for the data files for the SCIEX 7500 system or SCIEX 7500+ system.

In the Analyst software Results Table and the reports generated by the Analyst Reporter,
"Acquisition Methods" is shown as the acquisition method file name regardless of the MS
method used by the SCIEX OS software to acquire the data files for the SCIEX 7500 system or
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SCIEX 7500+ system. To show the correct MS method and LC method file names in the Results
Table and reports, use the Analytics workspace in the SCIEX OS software to process the data.
(AN-1931)

Detector data containing channels labeled with duplicated wavelengths cannot be
integrated in the Analyst software quantitation module

If detector data (PDA/DAD in 2D/Signal Mode, UV, Fluorescence, or any combination)
containing channels labeled with duplicated wavelengths is processed in the Analyst software
using the Quantitation Wizard, then only one of those channels is processed in the Results
Table. (AN-1940)

The Y-axis maximum might become extremely high in the peak review pane for some
analytes when using the option to zoom Y-axis to xx % of largest peak for all samples

Y-axis maximum might become extremely high in the peak review pane for some analytes when
the option to zoom the Y-axis to xx % of largest peak for all samples is used in the Peak
Review Default Options or Peak Review Options. Double-click the Y-axis of the chromatogram
for each sample to return the peak view to normal, or use the option to zoom the Y-axis to xx %
of largest peak instead. (AN-1302)

Only values of 0 or greater were exported in Quantitate mode for DAD data

If a user exports data using Save Active to Text File from a Peak Review pane or window

in Quantitate mode, then only positive data, 0 or greater, is exported to the text file for DAD
data. Negative numbers are not exported. To export a data list with both positive and negative
numbers, use Save As Text in the Data List pane in Explore mode. (AN-1566)

The unit in the titles for the Analyte Concentration and Calculated Concentration columns
in a Results Table is only for the first analyte

If a quantitation method used in a Results Table uses different units for different analytes, then
the unit in the titles for the Analyte Concentration and Calculated Concentration columns in the
Results Table is only for the first analyte. To view which units are used for all of the analytes, edit
the Table Settings to show the Analyte Units column. (AN-1357)

Disabling a quantitation security setting causes errors when Results Table column
settings are changed

Under Quantitation in the Access to Analyst list on the Roles tab in the Security Configuration
dialog, if the Disable, enable and clear audit trail permission is disabled, then the user cannot
change the column settings in a Results Table without getting an error each time. To change or
modify table settings, make sure that Disable, enable and clear audit trail is enabled for that
role. (AN-1018)
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The Sum Multiple lons option might produce results that are slightly incorrect

When using the Sum Multiple lons option in a quantitation method, users might notice that the
summed intensities of multiple ions is slightly different from the expected value (ion 1 + ion 2
+ion 3 and so on). This is due to a rounding issue within the Sum Multiple lons algorithm. In
practice, the difference will be very small and should not affect reported values. (AN-1)

The changed file name of the Results Table is not shown in the Regression window

If the user performs regression in the Analyst software (Quantitation module) and then saves the
Results Table using a new file name, the printout of the calibration curve still shows the original
file name. The calibration curve shows the new filename only after the file is closed and then
opened. (AN-555)

Adding a new column to a Result Table shows an error message but the column is added

If a new role is created in the Analyst software and the Disable, Enable or clear audit trail
(Quantitation) privilege is disabled, then adding a new column in a Results Table generates an
error message but the column is still correctly added to the table. (AN-641)

Discrepancy in Results Table file size

Depending on the number of samples, the Results Table file size might be larger than in the
previous version of the Analyst software. (ST 33496)

Printouts are incorrect if manual integrations are not accepted

If the user performs a manual integration and tries to print the window or workspace without first
“accepting” the changes (or completing an e-Signature, if required), the resulting printout might
be incorrect. The user sees two Results Tables printed showing the areas before and after the
manual integration, instead of the selected Results Table and chromatogram. If after performing
a manual integration, the user accepts the change (or completes an e-Signature) or navigates
to a different selection, the Print > Window and Print > Workspace commands functions as
intended.

Algorithm compatibility

Scheduled MRM (sMRM) algorithm data cannot be analyzed with Analyst Classic. The
IntelliQuan integration algorithms, IQA Il and MQ lll, should be used. Several behaviors are
observed in the software:

* When creating a quantitation method with Analyst Classic as the preset algorithm, the
software warns about algorithm incompatibility and the method uses IntelliQuan-MQ I
instead. The operation does not affect the preset algorithm. (ST 5388)

* IntelliQuan Results Tables from versions of the Analyst software earlier than 1.5 will continue
to use the previous versions of the algorithms in the Analyst software 1.5 so that the results

Release Notes Analyst Software 1.7.4
RUO-IDV-03-0236-H 73/97



Known Issues

presented are consistent. This is the only situation in which previous IntelliQuan algorithms
are used in the Analyst software 1.5.

+ The Quantitation wizard cannot create a quantitation method for a data file that contains more
than 94 transitions. Before using the Quantitation Wizard to generate a Results Table, create
the quantitation method using the Build Quantitation Method feature. Select this quantitation
method on the Create Quantitation Set - Select Method page of the Quantitation Wizard. (ST
5919)

» Previously generated quantitation methods with the Analyst Classic algorithm cannot be
used to analyze Scheduled MRM (sMRM) algorithm data. To carry forward the information,
export the method as text using the Create Text File from Quan Method script and then
import it using the Create Quan Methods from Text Files script. Both scripts are provided on
C:\Program Files (x86)\Analyst\Scripts\All Mass Spectrometers folder.

» Users cannot add Scheduled MRM (sMRM) aelgorithm data to Results Tables using the
Analyst Classic algorithms.

IQA Il Integration algorithm occasionally does not find peaks on Scheduled MRM (sMRM)
algorithm data

For Scheduled MRM (sMRM) algorithm data, it is recommended to use IntelliQuan - MQ Il
because the default integration algorithm, as the peak is sometimes not found in the retention
time window when using the Scheduled MRM (sMRM) algorithm with IQA II.

Default integration algorithms

Newly created projects always copy the default integration settings from the Default project. For
fresh installations of the Analyst software 1.5 and later, the preset is IntelliQuan - MQ Ill. If the
Analyst Data folderis used from a previous version, then the preset from that Default Project
will carry forward to the later version of the Analyst software.

Large signal-to-noise values are sometimes reported in the Results Table

Occasionally, when very low or no noise is selected for a background, very large values to over
20 digits are reported. This might occur because there is no baseline noise for these cases. The
signal-to-noise should be reported as N/A in these cases. Adjust the selection of the baseline to
make sure that some baseline noise is applied to the signal-to-noise calculation.

Baseline Sub window

The IntelliQuan Baseline Sub window is actually a half window. The window used is twice the
width that is entered. This applies both to the Integration tab of the Processing Options and
IntelliQuan Parameters dialogs opened by right-clicking in a data list. (SCR 12984)
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Exporting with Sum Multiple lons produces a bad text file

Exporting a Results Table built with the Sum Multiple lons option produces data in separate
columns. The values are shown under incorrect headers and the text file might be incorrect.
(SCR 10947)

Diode array detector results are not removed

In a DAD Results Table, even when all DAD data is removed and an ADC data sample is added,
the DAD information stays in the Results Table. (SCR 7998)

The Analyte mass range column contains N/A

If an automatic quantitation method is used to build a new Results Table, then the Analyte Mass
Ranges column contains N/A instead of the actual mass range for the corresponding sample
and analyte, which might be all different. (SCR 8790)

Peak asymmetry error

If a Results Table is created and Peak Asymmetry is shown, then the column shows 0.00 if no
peak is found. (SCR 10688)

Last decimal digit is inconsistent

If a Statistics table is opened for two Results Tables (by selecting Group By Concentration
from the Conc. as Rows box and selecting Area or Height from the Statistics Metric box), then
the last digit for some of the statistical results (Mean) could be different depending on the order
in which the data files are opened. The same issue is also seen in mean calculations. (SCR
13198)

Quantitation integration mass tolerance

The algorithm for selecting a particular MRM transition from the Q1 and Q3 masses stored in the
quantitation method operates as follows:

The transition whose masses are closest to the values from the quantitation method, but still
within a tolerance of 0.1 Da, is used. The software determines which transition is closest by
summing the Q1 mass variation and the Q3 mass variation (between the quantitation method
and the acquisition method) and then selecting the transition whose variation sum is the
smallest.

The quantitation of a sample with a large number of transitions might seem slow
For example:

* Generating a Results Table on the recommended computer using one sample containing
2,500 transitions can take about three minutes. (ST 9944)
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+ Creating or saving a quantitation method using Scheduled MRM (sMRM) algorithm data that
contains 2,500 transitions can take up to 15 minutes. (ST 9944)

Adding a Formula column causes the software to stop responding

If the user performs an operation using a Formula column in a Summary Page in a Results
Table the software stops responding. To prevent this behavior, remove the 500s in the brackets
in the column names in the Formula field. (ST 12940)

The Cancel button is unresponsive when an unsaved quantitation method is being closed

When a workspace with an open, unsaved quantitation method is being closed, the Cancel
button is not responsive. To close the window without saving the method, click No instead of
Cancel. (ST 15477)

The Analyst software stops responding when a Results Table is exported to a non-
existent directory

This issue occurs when the user specifies an incorrect path in the File name list by typing in the
path. Make sure that the path specified exists and is correct. (ST 15992)

The Save As dialog points to an incorrect folder

When users save a quantitation method that required a data file to open, the Save As dialog
points to the folder where the data file was located instead of the Quantitation Methods folder.
Browse to the appropriate folder before saving the quantitation method. (ST 16129)

A peak is not integrated as expected when the RT window is increased beyond 40
seconds

When the IQA Il algorithm is used, RT windows larger than 40 seconds are ignored. If the user
sets a window larger than this, then a window of +/- 20 seconds is used. Either adjust the
expected retention time for the shifted peak, or, for batches where this is happening for many
samples, use the MQ Il algorithm. (ST 17676)

An error occurs during quantitation using the TIC as the Q1/Q3 selection

If the Quantitation wizard is used and the TIC is specified as the Q1/Q3 selection, then the
Analyst software shows an error when the user advances the wizard. Click OK to successfully
continue with the wizard. (ST 3242)

Column sorting

Occasionally, sorting columns in tables does not produce repeatable results. Sort on the index
column to make sure that sorting is always correct.
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Quick Quant with full scan methods

In the Acquisition Batch Editor, creating a Quick Quant method causes inconsistent behavior if
the acquisition method selected is a full scan method. After saving this method, users cannot
open it. Quick Quant works as expected with all other scan types. It is recommended that users
do not use Quick Quant with full scan methods. (SCR 9866)

New Quick Quant methods do not apply new quantitation default values

New Quick Quant methods generated through Build Acquisition Batch do not use the modified
quantitation default values specified on the Quant Method Editor Settings dialog. (SCR 6997)

An intensity drop might be observed when a Scheduled MRM (sMRM) algorithm
experiment is run with masses greater than 1,000 Da

Avoid using masses above 1,000 Da in Scheduled MRM (sMRM) algorithm experiments. In
these instances, it is recommended that you use the MRM scan type. (ST 11772)

Some items unavailable under the Administrator role for the Quantitate module are
available

Although the Change default number of smooths (in Wizard) and Change concentration
units (in Wizard) are not available for the Administrator under role-based security, a user with
the Administrator role still has access to these features in the wizard. (ST 19149)

The concentration units specified when a quantitation method is created do not
propagate to the Results Table if different units are used per analyte

Although a user can enter different units for different analytes when creating a quantitation
method, only the first set of units is used in the Results Table. (ST 19151)

Incorrect data is shown in the calibration window

The data in the calibration window might not be consistent with the Results Table if few peaks
are found in the Results Table. To correct this issue, refresh the window by saving it. (SCR
11282)

Reporter Software

An incorrect operator might be shown in the Reporter software for samples appended to
a data file

If samples were appended to an existing data file that was acquired by a different user from
the current user who submitted the appended samples, then the Operator tag, if included in the
report template, shows the name of the user that first created the data file for the appended
samples, not the one who actually submitted those appended samples. (AN-1612)
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Reporter software cannot create reports on computers with the SCIEX OS software
installed first

On a computer with the SCIEX OS software already installed, installing the Analyst software
causes the Reporter not to work. A report cannot be created due to an unhandled exception
error. However, if the Analyst software is installed first, and then the SCIEX OS software

is installed, then the Reporter software works, even if the Analyst software is sequentially
upgraded to a higher version from the current configuration where the Analyst software was
installed first, and then the SCIEX OS software was installed. (AN-2032)

A report cannot be generated when the Library search template is used in the Reporter
software 3.2

When the user tries to create a report using the Library Search template in the Reporter software
3.2, an error message is generated that the report cannot be created. To resolve this issue,
contact SCIEX support at sciex.com/request-support. (AN-39)

The Reporter Template Editor might not show the Tags panel for the Blank Template

When the Blank Template in the Reporter software is edited, the tags panel might not be shown
by default, depending on the version of Microsoft Office used. If the panel is not visible, then
users can make it visible by selecting View > Document Editor, followed by View > Document
Actions. (AN-250)

Chromatograms are not shown if the Label field contains information

When a Reporter template is created, if the user adds a chromatogram and then types anything
in the label field for the tag, then the printed report does not show the chromatogram. To avoid
this issue, make sure that the label field is empty. (AN-255)

The Reporter Template Converter is unable to convert four templates

The Reporter Template Converter is unable to convert the following templates: Select
Analyst 20 percent Report.xml, Sample Report with MRM ratios.xml, Sample
Report with MRM ratios2.xml and Sample Report with MRM ratios EU.xml.
Users will receive an error message when attempting to convert any of these templates.
(AN-258)

Adobe Acrobat might stop responding after printing to PDF

If the user selects both of the Print to PDF and Print Automatically options, then after the
report is generated, Adobe Acrobat opens but stops responding. If the user manually closes
Adobe Acrobat, the report opens automatically as a PDF. This is a workflow defect and does not
affect the generation of the actual report. (ST 35621)

Report names containing periods might cause the Reporter to stop responding

When creating a report, if users specify a filename that contains periods (‘dots’), they must also
specify the file extension. Failing to do so causes an error to be generated: “Failed to process
the report file. Unsupported format requested.” For example, specifying a report as “report 1.2.3”

Analyst Software 1.7.4 Release Notes
78/97 RUO-IDV-03-0236-H


https://sciex.com/request-support

Known Issues

causes Reporter to stop responding. Specifying “report 1.2.3.docx” generates the report as
intended. The extension must match the format selected in the Reporter software. (ST 35636)

Installer

A message about DCOMPerm.dll might be shown during Analyst software installation

During the installation of the Analyst 1.7.4 software, a message "Cannot move DCOMPERM.dII
while installing DCOMPerm. Win32 errrorcode 262272. Please contact your software
manufacturer." might be shown. Click OK in the message to continue with the software
installation. This may be caused by CTC PAL scripts. However, as of version 1.7.4 of the Analyst
software, CTC PAL autosamplers are not supported. The software works as intended. (AN-767)

The Analyst software cannot be upgraded or reinstalled if the Waters Acquity LC Device
Driver has been installed on the computer or was previously installed on the computer
and then removed

If the Waters Acquity LC Device Driver has ever been installed on the acquisition computer,
even if it was later removed, users might have difficulties upgrading the Analyst software on
the computer or reinstalling it. This might result in users losing their instrument tuning files. The
issue is caused by the Waters driver and Waters support has been advised.

To avoid this issue, before performing an upgrade installation or re-installation of the Analyst
software, always make sure to restart the computer right before opening the Analyst software
setup.exe file. (AN-692)

Smart Services runtime error

Occasionally, a Smart Services runtime error appears when the HotFixes are installed on
uninstalled. Click through the error. The error does not affect the installation or removal of the
HotFixes. This error occurs only when Smart Services Mass Spec Gateway v 4.1 is installed.
(ST 11498)

Other

The Nebulizer Current status is not shown correctly in the Detailed Status window

On SCIEX 5500 systems, the Analyst software does not display the Nebulizer Current correctly
in the Detailed Status window while the instrument is in operation. A value of 0 is shown but

this does not accurately reflect the actual applied current. Contact an FSE if no change in
performance is observed when the nebulizer current is changed in the method or if an issue with
the nebulizer current is suspected.

Compatible Software

Automaton software support is discontinued
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The Analyst software does not support the Automaton software. The Automaton software
package is replaced by the DiscoveryQuant software.

Some LightSight software versions cannot create GSH precursor ion IDA methods

The LightSight software for metabolite identification is unable to create GSH precursor ion IDA
methods when the molecular weight of the molecule is greater than 550 Da. In version 2.0

and 2.1, the LightSight software cannot create GSH Prec IDA methods and in version 2.2, the
software cannot create GSH Prec IDA and GSH Prec/NL IDA methods. The LightSight software
can create GSH Prec methods for molecules with a molecular weight greater than 550 Da only if
an IDA method does not need to be created.

AAO Development Kit

Third party developers can find the AAO Development Kit on the Analyst software DVD or the
web dowload package, whichever is available, in the \Extras\AAO folder. The kit contains a
user guide, release notes, source files, sample code, and so forth.

When setting up a root directory for the AAC, make sure that the path name does not
include the word “Projects”

When setting up a root directory for Analyst Administrator Console (AAC), make sure that the
path name does not include the word “Projects”. If the path name includes the word “Projects”,
then a series of messages are returned to the user that prevent the user from logging into the
Analyst software through the AAC. The messages might indicate that the user does not have
access to the projects in the Workgroup to which they belong or that the projects included in the
Workgroup do not exist. Contact the administrator to rectify this issue. (ST 19394)

Connection from AAC to the AAC server

Connection from the AAC to the AAC server should be made using the IP address and not the
AAC server name. (ST 31068)

Scripts

The Convert Methods script does not show an error message on method conversion
failure

The Convert Methods script does not generate an error message when it is unable to convert
an acquisition method with Q1/Q3 above 1,250 for a SCIEX 6500 system (high mass mode) or
SCIEX 6500+ system (high mass mode) into a method for a SCIEX 5500 system. The Save
button is not available indicating that the method conversion cannot proceed. (AN-128)

The Purge Modifier script does not work if the Analyst Data folder is stored on a network
drive

For the Purge script to work, the Analyst Data directory must be stored on the local
computer. (AN-505)
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The Convert Methods script causes converted method to lose precision

In the acquisition methods converted using the Convert Methods script, the Q1/Q3 masses are
rounded to the nearest second decimal place, making these values different from the original
method. (AN-702)

Users should not launch scripts from the Analyst software folder in File Explorer

Some Analyst software scripts are available as exe files within the Analyst software folders.
However, these scripts should not be launched manually. They should only be launched from
within the Analyst software. (AN-120).

The AutoQuant with Automatic Reports.dll script does not support
Scheduled MRM (sMRM) algorithm data

When the BatchScriptDriver Script is run and if a Scheduled MRM (sMRM) algorithm data file
is selected to be processed with the AutoQuant with Automatic Reports.dll script, then an error
message is shown, indicating that samples are not compatible with the quantitation method.
Users can process MRM data successfully. (ST 9052)

The LabelXICs script labels traces with zeroes

If the LabelXICs script is run using Scheduled MRM (sMRM) algorithm data, then the XIC trace
is labeled with zeroes. The mass corresponding to each XIC can be found in the header of the
data file. (ST 6109)

The Mascot script fails to run for single EPI spectra

The Mascot script fails to run for single EPI spectra or for summed EPI spectra acquired with
MCA turned on. Click Explore > Show TIC, highlight the entire TIC or highlight a small region
around the peak of interest and then run the Mascot script. By default, the search option All
MS/MS spectra from selected region(s) in TIC is selected. This option will run correctly. (ST
8856)

The Exclusion List cannot be imported into an IDA Method

The Exclusion List created from the Make Exclusion List From Spectrum script cannot be
imported in an IDA method. To avoid any issues, enter headers in the list in the format provided
by the returned error message. (ST 2027)

The mass range for Q1 and Q3 scan data is not extracted

Occasionally, the XIC From Table script does not extract the entire mass range for Q1 and Q3

scan data. The error message that is shown, indicating the mass ranges that can be extracted,
can provide further guidance. Reopening the data file and then restarting the script might also

correct this issue. (ST 9646)
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Subsequent integrated area are not showing

When the Manually Integrate Script is run to integrate consecutive peaks, the blue integrated
area is visible only for the first run of the script for the first peak. Subsequent integrations using
the script do not show the blue area and the caption from the last integration remains. Reopen
the data file and then run the script again to see the integrated area. (ST 9650)

Incorrect ramp information is given for the AF2 parameter

On SCIEX 5500 systems, the MS3QuantOptimization Script reports the incorrect ramp
information for the AF2 parameter. The report shows that the AF2 parameter is ramped from
0 to 100 mV with a step size of 2 mV. The actual ramp range is 0 to 0.3 V with a 0.025 V step
size. (ST 9821)

The AF2 graph is not always legible

Occasionally, the AF2 graph produced by the MS3QuantOptimization script is illegible during
acquisition in the script user interface. This occurs only for graphs for which there is no resulting
spectral information. This does not affect the operation of the script. (ST 9822)

The starter method must have a syringe pump enabled for the MS3QuantOptimization
script

Make sure that the starter method has a syringe pump enabled. Open the starter method. If the
syringe pump has a cross, right-click to select Use to enable it, and then save the method. If the
syringe pump is not enabled, then the syringe pump will not run when the script is executed.

The Merge MRM Methods script causes the Analyst software to stop responding if the

hardware profiles being merged do not match

The Merge MRM Methods script causes the Analyst software to stop responding if the hardware
profile does not match the hardware profile used to create the methods being merged or if the
matching hardware profile is not active. To prevent this issue, make sure that the hardware
profile activated in the Analyst software matches the active hardware profile for the MRM
methods being merged. (ST 17455)

The Merge MRM methods script does not merge the Compound ID
Enter the Compound ID manually. (ST 2474)

An error occurs when Subtract Control Data from Sample Data is selected on the Scripts
menu

Press Shift while selecting the script. An About dialog opens and the script runs. (ST 6208)
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The XIC from BPC script causes the Analyst software to stop responding

Do not use this script. (ST 6209)

Inclusion and Exclusion lists are not copied when IDA methods are converted using the
Convert Methods script

To prevent this issue, edit the masses in the Inclusion and Exclusion lists of the original
method to fit within the accepted range of the destination method. (ST 18986)

Methods with LIT scan types that have mass ranges greater than 1,000 Da cannot be
converted to methods for the QTRAP 5500 system using the Convert Methods script

To avoid this issue, change the mass range of the original method to fit within the acceptable
range of the destination method. (ST 18670)

Convert Methods script

After a method is created using this script, review the new method to make sure that the method
has been converted to correctly.

Peripheral Devices
ExionLC 2.0 Systems

The status icon for the ExionLC 2.0 system in the Analyst software is red but shows
Ready

If an error occurs on the ExionLC 2.0 system, then the LC status icon in the Analyst software
turns red but Ready might be shown as the LC status. To recover, deactivate the hardware
profile and then activate it again. Make sure that the detector lamps are on and ready before
starting acquisition, especially after the system has gone through Standby state. (AN-1966)

The Analyst software shows the ExionLC 2.0 system in Wait state when it is in Standby
state if the LC system contains a detector

If the ExionLC 2.0 system contains a DAD or Multiwavelength detector, then after the LC system
and mass spectrometer go to Standby state, the Analyst software status icon for the ExionLC
2.0 system turns yellow, but the LC system state is shown as Wait. This occurs because the
detector lamps are turned off when the system is in Standby state. This is a status display issue
and does not affect system operation. (AN-1968)
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A method cannot be saved when valve wash is selected in the settings for the ExionLC
2.0 wash system

Intermittently, when valve wash is selected in the settings for thr ExionLC 2.0 wash system, the
method might not save successfully, instead showing an error message "Error writing acquisition
method to the file! Copy method failed." If this issue occurs, then do the following:

1. Deactivate the hardware profile and then close the Analyst software.

2. Delete or rename the Configuration Default.xml file
(C:\Programbata\ExionLC2.0\Configurations)and the ExionLC2 folder
(C:\ProgramData\SCIEX).

Restart the computer.
4. Turn off all of the ExionLC 2.0 system modules and then turn them back on.

Create a new hardware profile, reconfigure the ExionLC 2.0 system, and activate it.
(AN-2246)

Every two data points are duplicated for the pressure trace for the ExionLC 2.0 system

For the pressure trace for the ExionLC 2.0 system, every two data points are duplicated. This is
because the pressure values are collected at half of the frequency (0.5 Hz) of the publishing rate
(1 Hz). In addition, the first data point at time 0.0 min for all of the auxiliary traces are artificial
since the first actual point is usually collected at time greater than 0.0 min. (AN-2638)

ExionLC Systems or Shimadzu Devices

The room temperature trace is written when the LC system does not have a room
temperature sensor

For an ExionLC system or Shimadzu LC system with auxiliary trace enabled, the room
temperature trace is written and stored with the data file when no room temperature sensor

is present with the LC system. The trace might incorrectly show temperatures such as 650 °C.
(AN-2559)

Configuration of a newly created or edited hardware profile for an ExionLC system is
being applied to all existing hardware profiles that contain ExionLC system devices

If the configuration of a hardware profile containing an ExionLC system is changed or if a

new hardware profile containing any of these devices is created, then the configuration of
existing hardware profiles containing any of these devices is also changed automatically. All
configuration options such as Fast LC, psi units, relays, sync, system pressure max, and so
on are saved to every other hardware profile containing an ExionLC system, even if the edited
or newly created hardware profile is not activated. For example, if there is an active hardware
profile that includes a binary gradient ExionLC Pump and the user creates a hardware profile
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that includes an isocratic ExionLC Pump but does not activate the profile, then the active
hardware profile becomes isocratic as well. (AN-943)

ExionLC systems: The Configuration Ul dialog opens in the background behind all other
open windows after a fresh installation of the Analyst software or after the computer is
restarted

During hardware profile creation for ExionLC series devices, when the Configure button is
clicked, the Configuration Ul dialog opens in the background behind all of the other windows.
This happens after installation or after the computer is restarted. To bring the ConfigUIDialog
to the foreground (after clicking Configure), minimize all of the open applications until the
ConfigUIdialog is visible. After this, every time Configure is clicked, the Configuration Ul dialog
will always open in the foreground. (AN-717)

If the Remote Instrument status feature is used in the Analyst software, then the detailed
status for a connected ExionLC system is not shown

The detailed status of the connected LC system is blank when viewed from the Remote
Instrument Status. (AN-686)

Some methods with errors from LC can be saved but cannot be opened

When an acquisition method with an LC method parameter for the ExionLC system that is
outside of the allowed range is saved, the Analyst software generates an error about the wrong
value, but allows the user to save the method. However, this method cannot be loaded after
being closed and cannot be used for acquisition. (AN-678)

In Manual Tune, all the parameters for pump, autosampler, and system controller are not
shown when LC method is selected for ExionLC devices

When LC Method is selected in the Manual Tune mode for a hardware profile containing
ExionLC devices, the timetable (located on the right side of the Pump, Autosampler, and System
Controller tabs) is not shown. As a workaround for this issue, create the acquisition method in
the Acquisition Method Editor, save it and then open it in Manual Tune mode. (AN-644)

A method with invalid LC parameters can be saved with an error but cannot be opened

When an acquisition method with an LC parameter outside of the allowed range is saved, the
Analyst software shows an error about the wrong value but generates the method. However, this
method cannot be opened after being closed and cannot be used for acquisition. This issue is
applicable for most LC systems, including the Shimadzu LC-40 system. Agilent LC systems are
not impacted. (AN-1813)
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In Manual Tune, not all of the options for the modules are shown when an LC method
is selected for Shimadzu LC-20/30 devices activated through the Integrated System
Shimadzu LC-20/30 Controller, or for Shimadzu LC-40 devices

If an LC Method is selected in Manual Tune for a hardware profile containing Shimadzu
LC-20/30 devices activated through the Integrated System Shimadzu LC-20/30 Controller, or for
a hardware profile containing Shimadzu LC-40 devices, then the following options are missing
from the right side of the module window:

+ Time Program option, for all modules that have the Time Program option enabled in the
Acquisition Method Editor

* Pretreatment option, for the Autosampler module
*  Pump mode switching option (B. GE vs I1SO), for the LC-40 Pump module
* Autopurge option, for the LC-40 Pump module

As a workaround for this issue, create the acquisition method in the Acquisition Method Editor,
save it, and then open it in Manual Tune mode. (AN-1812)

The Shimadzu HPLC stack does not go into Standby state when Standby is selected
during equilibration

The Shimadzu HPLC stack does not go to Standby state when Standby is selected during
the equilibration period. The mass spectrometer goes to Standby state but the pump and
oven continue to run. As a workaround, first press Ready and then press Standby during
equilibration. (AN-663)

Shimadzu LC-30 devices: An error might occur when the queue is restarted after samples
are aborted

If a Shimadzu LC-30 is configured with Integrated System Shimadzu LC-20/30 Controller, then
occasionally after the user aborts a sample run or stops the queue, and subsequently starts the
queue again, the next sample might show the acquisition error: Operation failed, device
driver exception. To prevent the issue, deactivate and then activate the hardware profile
again after a sample is stopped or aborted. (AN-3092)

An incorrect response time might be used on Shimadzu SPD-40/40V UV detectors with
SCL-40/CBM-40/CBM-40 Lite ROM version earlier than 1.64.

If firmware versions earlier than 1.64 are used on a Shimadzu SCL-40, CBM-40, or CBM-40
Lite controller connected to a Shimadzu SPD-40/40V UV detector, then an incorrect interaction
between the Response mode and the Sampling time causes an incorrect response time. If the
response mode for the SPD-40/40V is set to Fast/Standard/Slow, then analysis is done with
response times of 0.5 s, 1.0 s and 2.0 s, respectively, regardless of the Sampling setting. There
is some influence on the data.
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Workaround: Change the Response mode to Other, and then set the numeric value field to the
response time value or to a value that is less than the related sampling time. As an alternative,
use SCL-40/CBM-40/CBM-40 Lite firmware version 1.64 or later.

AutoConfig shows the same serial number for all pumps

The Shimadzu driver included in the Analyst software adds the ability to automatically scan and
configure the hardware profile based on the devices attached to the CBM module. A defect in
this driver causes all connected pumps to show the serial number of the first pump. However, if
the devices are manually configured using the integrated device driver in the Analyst software,
then the File Info for acquired data reflects the correct serial numbers. (TT 35101)

The layout of the 1.5 mL cooled rack has been changed

A new high capacity 1.5 mL cooled rack has been introduced for the Shimadzu LC-30 series
autosampler. The layout of this rack has been changed to accommodate the 105 vials and
therefore cannot be selected using the existing 1.5 mL Cooled rack option from the Location tab
in the Batch Editor. To use this new rack, select the 1.5 mL Standard rack. The new rack will still
be cooled. (ST 34061)

The IP address must be typed to establish an Ethernet connection
When establishing an Ethernet connection, the Shimadzu device search function cannot retrieve
the IP address from the Shimadzu CBM. Users must type the IP address. (ST 29400)

If a different user logs on to the Analyst software, then the Shimadzu AAO might stop
responding

In Mixed Mode, if a different user logs on to the Analyst software, then the Shimadzu AAO might
stop responding. If this issue occurs, stop the AnalystService and the ShimadzuAAO. exe using
Task Manager and then start the Analyst software. (ST 33331)

Batches can fail if the post treatment cycle does not complete before sample acquisition
has completed

For the Shimadzu LC-30 series autosampler, when creating an acquisition method, do not select
After Acquisition from the Rinsing Start Time list on the Internal Rinse dialog. Select Specify
Start Time or do not use this option in the acquisition method. The internal rinse must be
completed before the sample acquisition has completed. (ST 33825)

Queue functionality is lost

Performing an abort when a Shimadzu device is in the Equilibrate mode (by manually putting
the device in the Standby or Ready state before Equilibration has completed) results in a loss of
queue functionality. To regain control of the queue, stop the AnalystService and power-cycle the
Shimadzu stack. (SCR 9588)
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Shimadzu SIL-10AF and SIL-10AxI autosamplers are not supported

The Shimadzu SIL-10AF and SIL-10AxI autosamplers are not supported even though the
option exists in the Hardware Configuration Editor in the Analyst software. Do not select these
autosamplers because the user might not be able to activate the hardware profile.

Enabling additional devices in the Shimadzu Prominence stack might require a reboot of
the stack

When additional devices are enabled in the Shimadzu Prominence stack (such as the rack
changer), a full reboot of the stack might be required to allow the hardware profile to be
successfully activated in the Analyst software.

Loss of synchronization occurs when short acquisition times are specified for a
Shimadzu Prominence stack

A loss of synchronization between the Analyst software and the Shimadzu Prominence stack
might occur if the acquisition time specified is shorter than the time required for the autosampler
to complete the rinse washes. Make sure that the MS acquisition method is at least one to two
minutes long.

The pump pressure maximum limit might need to be increased during creation of a
Shimadzu method

The default pump pressure maximum limit might be too low and might lead to pressure errors
on the hardware and subsequent acquisition errors. Therefore, the default limit might need to be
increased when Shimadzu methods are created.

No error message is shown when a Shimadzu deep-well plate is missing

If a deep-well plate is missing in the Shimadzu autosampler, then the autosampler fails to detect
it and the run proceeds without the software being notified of any error.

Issues occur when AnalystService is restarted

If the user restarts the computer or the AnalystService.exe (with the Windows Services control
panel), then the system might stop responding. Power-cycle the Shimadzu controller and then
activate the hardware profile in the Analyst software to help restore the system. (SCR 13266)

The user needs Windows local Administrator rights to modify the hardware profile

To create or modify hardware profiles that include Shimadzu devices, the user must be a
Windows Local Administrator or have equivalent permissions. (SR 11858, SCR 13261)

The wrong vial number is sent to the autosampler
When Shimadzu devices are used, the wrong vial number is sent to the autosampler if rack type
4 isin use. (SCR 12010)
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Reset the device from the controller manually

Reset the Shimadzu autosampler from the controller after an abort or failure. Currently, there is
no way for the Analyst software to do this automatically. (SCR 10532, SCR 12921)

Issues occur because of a mismatch of duration time

The default duration for Shimadzu methods is 90 minutes. When tuning with a mass
spectrometer scan duration shorter than the Shimadzu time program duration (as in the default
tune method), the user is not able to stop the tune run using the Analyst software after the mass
spectrometer has finished scanning. Press run on the controller or change the default Shimadzu
time program duration to match the MS duration in the Shimadzu method editor. (SCR 9515)

Clearing Fail whole batch in case of missing vial does not work

Clearing this feature found in Tools > Settings > Queue Options does not work. The batch fails
regardless of whether the user has selected this check box.

Shimadzu Rack Changer racks are incorrectly labeled

Currently, the Shimadzu Rack Changer racks are labeled as follows: 1.5 mL Vial Cooled, MTP
96 Cooled, MTP 384 Cooled, Deep Well MTP 96 Cooled, and Deep Well MTP 384 Cooled. The
Shimadzu Rack Changer racks are not offered in the cooled format but are incorrectly labeled
with the “Cooled” suffix. Ignore the “Cooled” suffix. These trays do not provide the cooling
capability. (ST 18032)

DAD Devices

Use a single wiff file for large data

If a large amount of data is acquired using a Diode Array Detector (DAD) to a single wiff file,
then the file might become corrupted. To prevent issues, always acquire DAD data to multiple
wiff files if a large number of samples are acquired.

Agilent Devices

The IDA Method Wizard user interface for the triple quadrupole mass spectrometer might
be shown when a hardware profile that contains an Agilent 1260 DAD or 1290 DAD and a
QTRAP mass spectrometer is activated

For a hardware profile with an Agilent 1260 DAD or 1290 DAD added before a QTRAP mass
spectrometer, the IDA Method Wizard user interface for a triple quadrupole mass spectrometer
is shown, even though the activated mass spectrometer is a QTRAP mass spectrometer. The
issue only occurs if an Agilent 1260 DAD or 1290 DAD is added to the hardware profile before
the QTRAP mass spectrometer. The issue does not occur with hardware profiles that contain an
Agilent 1100 or 1200 series of DAD, or hardware profiles that do not contain an Agilent DAD.
(AN-140)
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Integrated Agilent LCs stop running the LC method at the mass spectrometer stop time

not the pump stop

time

If the mass spectrometer method duration is shorter than the Agilent LC method duration, both
sample acquisition and the LC run stop at the mass spectrometer stop time. To avoid the issue,
set up the acquisition method with the same stop time for the mass spectrometer and the LC

method. (AN-2657)

Acquiring DAD data at rates greater than 20 Hz is not recommended

For the Analyst software, the guidance is 20 Hz and less. Using higher acquisition rates causes
the acquisition to take much longer than expected. (ST 25396, ST 35524)

The Agilent 1260 Pump G4220B is not supported (ST 33318)

Agilent Pumps

Compatibility

Agilent 1260 and

The Agilent 1260 and 1290 pumps cannot be used in the same hardware

1290 pumps profile. (ST 33313)

Agilent 1260 The Agilent 1260 G1329B autosampler must be configured as an Agilent
G1329B 1200 G1329A autosampler to operate. (ST 34104)

configuration

Compatibility with
Agilent 1200
Methods

Acquisition methods that were created for Agilent 1200-series devices can
be opened and used if the current hardware profile includes Agilent 1260-
series devices that are functionally equivalent to the 1200-series devices
used in the method. The following devices are functionally equivalent:

* 1200 G1312B Binary Pump SL and 1260 G1312B Binary Pump
* 1200 G1316A Column Oven and 1260 G1316A Column Oven

Note: For methods to be compatible, all of the devices in the currently active hardware profile
must be the same as, or functionally equivalent to, the devices used in the original method.

was created with a

Note: If a previously created (1200) acquisition method is used to acquire data with a
functionally equivalent 1260-series device, then the File Info shows that the acquisition method

the new 1260-series device active in the hardware profile and then save it (or save as a new
method and then use the new method for acquisition).

1200-series device. To avoid this issue, open the acquisition method with

Purging and priming issues using the Analyst software

The 4220A Binary Pump uses an integrated software-controlled purge valve.

The Analyst software supports this functionality in both the Acquisition Method Editor and
Manual Tuning through the Purge option.
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Figure 4-1 Purge Option in the Acquisition Method Editor
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Figure 4-2 Purge Option in Manual Tuning
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When the Purge option is activated, the Agilent 1290 Binary Pump opens the purge valve,
allowing system purging.

To create a purging method, use only the Total Time, Flow Rate, and A/B(%) fields. Values
entered in the Limits, Limits (Advanced), and Micro Mode tabs are ignored.

Use Manual Tuning to purge or prime the system or create an acquisition method to be used
exclusively for purging. This method can be submitted with the Acquisition Batch Editor in the
same manner as acquisition methods. In this scenario, the mass spectrometer acquires data to
the specified wiff file.
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Figure 4-3 Example Acquisition Batch with a Purge Method Before Acquisition
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Changes to DAD acquisition

The Agilent 4212A and 4212B DADs have a single lamp source. The usable wavelength range
is 190 to 640 nm. Additionally, the 4212A DAD supports slit widths up to 8 nm, and the 4212B
has a fixed slit width of 4 nm.

Baud Rate for Serial communication

If the Agilent 1290 or 1260 stack is configured for serial (RS232) communication, make sure that
the baud rate is set in the Analyst software to 19,200.

Fractional injection volumes are not supported for Agilent autosamplers

When fractional injection volumes are requested, the decimal portion is truncated and only the
integer value is injected. For example, if an injection of 2.5 uL is attempted, the actual injection is
2 pL. (ST 28340)

A hardware profile containing an Agilent DAD 1315D cannot be activated

When attempting to activate a hardware profile containing an Agilent DAD 1315D that has an
incorrect IP address assigned to it, the Analyst software stops responding. Make sure that the IP
address is the actual address of the DAD.

Agilent wellplate

Agilent well plate autosamplers generate a fault when a vial is missing. Reactivate the hardware
profile and device to recover. (SCR 12060)

Agilent 1200 peripheral devices cannot use CAN connections over Ethernet
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Known Issues

To use these peripheral devices, configure each peripheral independently using an Ethernet
connection through an Ethernet hub or connect each using an RS-232 cable. (ST 16108)

LC Packings Devices

The device has issues locating reagent vial positions

The Famos Autosampler User Defined Program (UDP) does not properly locate Reagent Vial
positions. (SCR 12204)

Users must define pressure in bar units

If the UltiMate Integrated System is used, then select the pressures in bar units. (SCR 9257,
SCR 13863)

Missing vials cause acquisition issues

Acquisition issues might occur if there are missing vials in a large batch with LC Packings
devices (both Famos and UltiMate). (SCR 9353)

PerkinElmer

The last decimal number is missing in the Status dialog

The flow rate of a PerkinElmer pump reported in the Status dialog during acquisition is missing
the last decimal number. For example, if the pump flow rate is 0.075 mL/minute, then the report
shows 70 pL/minute instead of 75 pL/minute. (SCR 11370)

Tempo MDLC System

Acquisition using the Tempo MDLC system occasionally stalls

Occasionally, a sample in a batch submitted to the Queue shows as Acquiring even after the
acquisition time is complete and the remaining samples show a status of Waiting; the batch
never advances to the next sample. This issue is intermittent. If it occurs, then resubmit the
remaining samples.
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21 CFR Part 11 Compliance 5

The Analyst software can be used to make sure that the site complies with the 21 CFR Part 11
Electronic Records and Electronic Signatures regulations. This compliance relies on the ability
of the administrator ability to create a secure environment for generating, analyzing, and storing
data. Compliance often involves the software of many different vendors for functions ranging
from laboratory information management system (LIMS) to data acquisition and from processing
to archiving. The Analyst software has the necessary features for creating and maintaining an
electronic record system by providing valid electronic records of the acquisition and quantitative
processing of data.

The Analyst software is designed to be used as part of a 21 CFR Part 11 compliant system
and can be configured to support 21 CFR Part 11 compliance. Whether the use of the Analyst
software is 21 CFR Part 11 compliant is dependent on the actual use and configuration of the
Analyst software in the lab.

Validation services are available through AB SCIEX Global Services - Regulated and Clinical
Markets. For more information, contact complianceservices@sciex.com.
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Programs and Utilities

A

The following utility is installed with the Analyst software in the C: \Program Files
(x86) \Analyst\Bin folder.

Table A-1 Utilities

Program

Description

Translat.exe

Utility to convert Agilent data files to the data format for the Analyst
software and Macintosh Library files to the library format for the Analyst
software. Enables creation of databases on SQL Server. Translat.exe
does not work over a network for Agilent data.

exe

CFR_FileCheck.

Utility to rerun the installation qualification test. It is accessible from the
Windows Start menu.
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Contact Us

Addresses

AB Sciex Pte. Ltd.
BIk33, #04-06 Marsiling Industrial Estate Road 3
Woodlands Central Industrial Estate, Singapore 739256

ﬁg;i’;ua ore  ABSciexLLC
250 Forest Street
Marlborough, MA 01752
USA

Customer Training

* Global: sciex.com/contact-us

Online Learning Center

+ SCIEX Now Learning Hub

SCIEX Support

SCIEX and its representatives have a global staff of fully-trained service and technical
specialists. They can supply answers to questions about the system or any technical issues
that might occur. For more information, go to the SCIEX website at sciex.com or use one of the
following links to contact us.

+ sciex.com/contact-us

» sciex.com/request-support

Cybersecurity

For the latest guidance on cybersecurity for SCIEX products, visit sciex.com/productsecurity.

Documentation

This version of the document supersedes all of the previous versions of this document.
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Contact Us

To find software product documentation, refer to the release notes or software installation guide
that comes with the software.

To find hardware product documentation, refer to the documentation that comes with the system
or component.

The latest versions of the documentation are available on the SCIEX website, at sciex.com/
customer-documents.

Note: To request a free, printed version of this document, contact sciex.com/contact-us.

Release Notes Analyst Software 1.7.4
RUO-IDV-03-0236-H 97/97


https://sciex.com/customer-documents
https://sciex.com/customer-documents
https://sciex.com/contact-us

	Release Notes
	Contents
	Introduction
	How to Use These Release Notes

	New in Version 1.7.4
	New Features and Enhancements in Version 1.7.4
	Analyst 1.7.3 HotFix 1, 2, and 3 Enhancements

	Fixed Issues in Version 1.7.4
	Issues Fixed in Analyst 1.7.3 HotFix 3 and Included in the Analyst Software 1.7.4
	Issues Fixed in HotFix 2 and Included in the Analyst Software 1.7.4
	Issues Fixed in HotFix 1 and Included in the Analyst Software 1.7.4


	Notes on Use
	Guidance for Antivirus and Backup Software
	Guidance on File Encryption
	General
	Acquisition
	Analyst Reporter
	Audit Trail
	Explore
	Method and Batch Files
	Peripheral Devices
	Quantitation

	Known Issues
	Audit Trail
	Configure — Administration/Security
	Configure — Hardware Configuration
	Tune and Calibrate — Compound Optimization
	Tune and Calibrate — Instrument Optimization
	Tune and Calibrate — Manual Tuning
	Acquire — IDA and IDA Method Wizard
	Acquire — Acquisition Method Editor
	Acquire — Method/Batch Editor/Queue Manager
	Acquire — Scheduled MRM (sMRM) Algorithm
	Acquire — Network Data Acquisition
	Explore
	Explore — Library Search
	Explore — wiff Data File
	Quantitate
	Reporter Software
	Installer
	Other
	Compatible Software
	Scripts
	Peripheral Devices
	ExionLC 2.0 Systems
	ExionLC Systems or Shimadzu Devices
	DAD Devices
	Agilent Devices
	LC Packings Devices
	PerkinElmer
	Tempo MDLC System


	21 CFR Part 11 Compliance
	Programs and Utilities
	Contact Us
	Addresses
	Customer Training
	Online Learning Center
	SCIEX Support
	Cybersecurity
	Documentation



